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Preface

This guide describes:

• Types of Advanced Server licenses

• Step-by-step instructions for using the Advanced Server license
management software

• How to use the Advanced Server License Manager

• How to troubleshoot licensing problems

This guide contains information about licensing requirements for both
PATHWORKS V6.1 for OpenVMS (Advanced Server) and Advanced Server
V7.3B for OpenVMS. The term ‘‘Advanced Server license’’ applies to the license
required to access the specific version of the file server.

About This Guide
This guide is written for system administrators who need to:

• Gain a basic understanding of Advanced Server licensing concepts.

• Ensure that valid clients receive licenses.

• Manage licenses.

• Solve and eliminate license management problems.

This guide assumes you are familiar with basic license management software
provided with the HP OpenVMS operating system.
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Organization of This Guide
This guide contains the following sections:

Chapter Description

Chapter 1 Provides an overview of the License Server software
and the license management tasks you perform

Chapter 2 Describes how you configure and manage
the License Server software in your network
environment

Chapter 3 Describes how to configure the License Server
software components on OpenVMS systems

Chapter 4 Describes how to use the License Manager

Chapter 5 Describes client software components that might
be used with the License Server and how to obtain
them, if necessary

Appendix A Lists and describes the messages that are generated
in response to server events

Related Documents
The following table lists related Advanced Server for OpenVMS documents:

Document Description

HP Advanced Server for
OpenVMS Server Installation
and Configuration Guide

Explains how to install and configure Advanced
Server software

HP Advanced Server for
OpenVMS Concepts and
Planning Guide

Provides an overview of and introduction to
the Advanced Server software and associated
networking concepts for system administrators and
operators

HP Advanced Server for
OpenVMS Server Administrator’s
Guide

Explains how to manage and customize the
Advanced Server software

HP Advanced Server for
OpenVMS Commands Reference
Manual

Provides command syntax descriptions for all
ADMINISTER commands and NET command
equivalents

x



The following table lists related PATHWORKS for OpenVMS (Advanced
Server) documents:

Document Description

Compaq PATHWORKS for OpenVMS
Server Migration Guide

Explains how to upgrade a PATHWORKS
(LAN Manager) server to PATHWORKS V6
for OpenVMS (Advanced Server)

Compaq PATHWORKS for OpenVMS
(Advanced Server) Server Installation
and Configuration Guide

Explains how to install and configure
PATHWORKS for OpenVMS software

HP Advanced Server for OpenVMS
Concepts and Planning Guide

Provides an overview of and introduction to
the PATHWORKS for OpenVMS (Advanced
Server) software and associated networking
concepts for system administrators and
operators

Compaq PATHWORKS for OpenVMS
(Advanced Server) Server Administrator’s
Guide

Explains how to manage and customize
the PATHWORKS for OpenVMS (Advanced
Server) software

HP Advanced Server for OpenVMS
Commands Reference Manual

Provides command syntax descriptions for
all ADMINISTER commands and NET
command equivalents

xi



The following table lists related OpenVMS documents:

OpenVMS Document Description

HP OpenVMS Version 8.3 Upgrade and
Installation Manual

Describes how to install the OpenVMS
Alpha Version 8.3 system software

OpenVMS VAX Version 7.1 Upgrade and
Installation Manual

Describes how to install the OpenVMS VAX
Version 7.1 system software

OpenVMS VAX Version 7.2 Upgrade and
Installation Manual

Describes how to install the OpenVMS VAX
Version 7.2 system software

HP OpenVMS System Manager’s Manual A task-oriented guide (in two volumes) to
managing an OpenVMS system; describes
how to set up the required system services

HP OpenVMS System Management
Utilities Reference Manual

A reference guide (in two volumes) to the
utilities and tools used in managing an
OpenVMS system

HP OpenVMS License Management
Utility Manual

Explains how to load and manage license
Product Authorization Keys (PAKs)

For additional information about the OpenVMS products and services, access
the following OpenVMS World Wide Web address:

http://h71000.www7.hp.com/openvms

Reader’s Comments
HP welcomes your comments on this manual. Please send comments to either
of the following addresses:

Internet openvmsdoc@hp.com

Mail Hewlett-Packard Company
OSSG Documentation Group, ZKO3-4/U08
110 Spit Brook Rd.
Nashua, NH 03062-2698

How To Order Additional Documentation
Use the following World Wide Web address to order additional documentation:

http://www.hp.com/go/openvms/doc

If you need help deciding which documentation best meets your needs, call
800-282-6672.
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Conventions
The following conventions are used in the Advanced Server documentation
set:

Convention Meaning

Advanced Server Advanced Server refers to the PATHWORKS for OpenVMS
(Advanced Server) as well as Advanced Server for OpenVMS file
server.

Italic Italics text indicates a place holder for information or parameters
that you must provide. For example, if the procedure asks you to
type file-name, you must type the actual name of a file.

Italic text also indicates path names, new terms, and the titles of
other documents.

monospace Monospace text indicates the actual commands, words, or
characters that you type in a dialog box or at a command prompt
or system output.

Note The use of Note provides information of special importance.

Caution The use of Caution provides information to avoid damaging the
software or hardware.

Warning The use of Warning provides information that is essential to
people’s safety.

/ A forward slash in command descriptions indicates that a
command qualifier follows.

. . . A horizontal ellipsis following an entry in a command line
indicates that the entry or a similar entry can be repeated any
number of times. An ellipsis following a file name indicates that
additional parameters, values, or information can be entered.

.

.

.

A vertical ellipsis in an example indicates that not all the data is
shown.

Ctrl/x While you hold down the Ctrl key, press another key or a
pointing device button.

Return or Enter The use of Return or Enter in text indicates where you should
press the Return or Enter key to execute a command or
terminate a sequence. This key is labeled Return or Enter,
depending on your keyboard.
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Convention Meaning

Tab In examples, a key name enclosed in a box indicates that you
press a key on the keyboard. (In text, a key name is not enclosed
in a box.)

In the HTML version of this document, this convention appears
as brackets, rather than a box.

PF1 x A sequence such as PF1 x indicates that you must first press and
release the key labeled PF1 and then press and release another
key or a pointing device button.
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1
How to Use Advanced Server License

Software

Any client accessing an Advanced Server must be sufficiently licensed. This
chapter describes how the license software works, the licenses required to
access the server, and how license management works. The following topics
are discussed:

• Section 1.1, The Advanced Server Licensing System, describes the different
components of the licensing system and describes how licensing works.

• Section 1.2, License Management Models, describes the different license
management approaches to providing access to the Advanced Server.

• Section 1.3, License Management Tasks, describes the tasks involved
in managing Advanced Server licenses and the features of the License
Manager that allow you to perform these tasks.

1.1 The Advanced Server Licensing System
The Advanced Server license software on the server runs on the OpenVMS
operating system and includes the following components:

• License Server – A software program that assigns and verifies client-
based licenses and performs license management tasks.

• License Manager—A management interface between the system
administrator and the Advanced Server License Server.

• License Registrar—A program that runs on every Advanced Server node
and validates that client access to the file server is licensed. The License
Registrar also grants server-based licenses.

The licensing software that runs on the client includes the following
components:

• Client License Requester—A program that runs on the client and
requests licenses from the License Server.

How to Use Advanced Server License Software 1–1
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1.1 The Advanced Server Licensing System

• Client License Transponder—A program that runs on the client
and communicates information about the client’s license to the License
Registrar.

See Chapter 5, Client Licensing Software, for more information about the
client licensing software.

The organization of these components is shown in Figure 1–1, Advanced Server
Licensing System.

Figure 1–1 Advanced Server Licensing System
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! Client requests license assignment or verification.

" Client establishes new session with file server.

# File server requests to validate that the client is licensed for access to file
server resources.

$ License Registrar validates a client’s license or assigns a server-based
license.
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1.1.1 Advanced Server Licensing System Components
The following list summarizes how the components of the licensing system
interact:

• The Advanced Server License Server is installed and configured on an
OpenVMS system. This can be a standalone system or an OpenVMS
Cluster and does not necessarily have to be on the same system as the
Advanced Server. The Advanced Server License Server is an interface
between the LMF database and the client licensing software. It services
requests for client-based licenses.

• The License Registrar runs on every Advanced Server system and
determines if a client is licensed to use the Advanced Server resources. The
License Registrar validates client-based licenses and grants server-based
licenses when they are needed and available.

For server-based licensing, Advanced Server licenses are loaded and
registered on the file server system. The License Registrar also maintains
information about the licenses and periodically interfaces to LMF to
determine changes to licenses, such as the addition of new licenses and the
removal of licenses.

When unlicensed clients access the Advanced Server resources, they
are granted server-based licenses by the License Registrar, if they are
available. These licenses must be available to the License Registrar for
such server-based use ahead of time.

• The License Manager:

Manages client-based licenses

Specifies how many licenses will be used as client-based licenses and
how many licenses will be used as server-based licenses

Organizes client-based licenses into license groups

Generates reports of licensing activities

Displays lists of clients that have been granted licenses

Revokes licenses

• Clients use the client license requester (CLR) and the client license
transponder (CLT) programs to request and verify licenses. The CLR
program requests client-based licenses from the License Server. When the
License Server assigns a license to the client, the client provides license
information to the CLT program. Each time the client establishes a session
with Advanced Server resources, the CLT program presents this license
information to the License Registrar so that the license can be validated.
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For a system to be an Advanced Server License Server, no special attributes
are required. However, make sure that the system is configured for, and
running, all of the transports used by clients requesting licenses.

A small amount of disk storage space on the server, less than 500 bytes per
license managed, is also required.

HP recommends that you use a single License Server to provide client-based
licenses to all clients requiring a client-based license in a local area network
(LAN). There is no technical reason why you could not use a single License
Server per wide area network (WAN) or multiple License Servers per LAN;
these models are also supported. However, using a single License Server per
LAN, at least to start, provides a good degree of local control while keeping
the administrative activity to a minimum. Also, operating too many License
Servers within a single LAN can result in performance degradation.

For increased availability, a License Server can be run in an OpenVMS Cluster.
Alternatively, two or more License Servers can be run, although any given PAK
can only be loaded on one OpenVMS system at a time.

When registering and loading a new Advanced Server license PAK on an
OpenVMS Cluster, use the LICENSE REGISTER command on one node of the
cluster to register the PAK and then use the LICENSE LOAD command on
each cluster member to load the licenses on that cluster member. This ensures
that Advanced Server license components running on any member of the
cluster will be able to detect the new licenses. Failure to load the licenses on
each cluster member may cause failures due to the Advanced Server licenses
components’ inability to detect licenses that are not loaded.

1.1.2 Configuring License Services
When you install the Advanced Server, the License Registrar is automatically
installed to ensure that access to the server resources is validated. The
License Server, however, is an optional component that is installed only if
you answer YES to the appropriate prompt in the initial configuration dialog,
PWRK$CONFIG, described in the Server Installation and Configuration Guide
for your Advanced Server product.

The License Server manages client-based licenses, including assignment of
licenses to clients and allocation of licenses to license groups.

If you choose not to configure the License Server to run, the License Registrar
takes its licenses directly from LMF (the License Management Facility) and
uses them exclusively as server-based licenses. Simply load the licenses as
described in the HP OpenVMS License Management Utility Manual.
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If you choose to configure the License Server, use the procedures described in
this guide to allocate and manage licenses. For more information on choosing
client-based versus server-based licensing, see Chapter 2, Setting Up License
Management.

When the Advanced Server is started, the License Server (if configured) and
the License Registrar are started using the following command procedures:

• SYS$STARTUP:PWRK$LICENSE_S_START.COM

• SYS$STARTUP:PWRK$LICENSE_R_START.COM

These command procedures contain complete descriptions of the configuration
parameters used by each process when it runs. For more information about
these parameters, see Section 2.6, License Server and License Registrar
Configuration Parameters. In addition, Section A.2, License Server Events,
includes information about parameters that control the reporting of events that
are logged to the License Server log file. Section A.3, License Registrar Events,
includes information about parameters that control the reporting of events that
are logged to the License Registrar log file.

1.1.2.1 Configuring Standalone License Servers
The License Server can run on a different system than the one that is running
the file server (such as the Advanced Server or the PATHWORKS Advanced
Server). HP recommends this configuration for the best performance of the file
server system. The system running the License Server without a file server is
referred to as a ‘‘standalone License Server.’’

To configure a system to run the standalone License Server, install the file
server software as described in the Server Installation and Configuration Guide
for your Advanced Server product. During the product installation procedure,
you should answer NO to the question about installing the Advanced Server,
and answer YES to the question, ‘‘Do you want to install only the Advanced
Server License Server?’’ When the procedure completes, configure and start the
License Server as described in the Server Installation and Configuration Guide
for your Advanced Server product.

When you install the file server on another system in the local area network
(LAN), configure the server so that the License Server is not started on the
same system with the file server.
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1.1.2.2 PWLIC and PWLicense Shares
The Advanced Server includes a copy of the Windows client software necessary
to implement client-based licensing. If you have or plan to implement server-
based licensing only, this software is not required on the Windows clients.

The Windows client licensing software may already exist in the Advanced
Server shares PWLIC and PWLICENSE. For more information about how to
create these shares, please refer to the Server Installation and Configuration
Guide

For more information about License Server configuration, see Chapter 3,
Configuring License Servers.

Note

Wherever the PWLIC or PWLICENSE shares are referred to in
this document, it is assumed these shares exist. Note that, on
PATHWORKS V6.1 PWLIC and PWLICENSE shares are installed
by default.

1.1.2.3 Configuring LANs and WANs
HP recommends that the License Server be installed and running in the same
LAN as the file server that the clients need to access, if you are using client-
based license management. Clients on computers outside of the LAN can
obtain licenses for access to the file server, if the License Server is configured
for wide area network access. For more information about how to provide WAN
access to the License Server, see Section 5.3, Enabling Wide Area Network
(WAN) Operations,

1.1.3 PATHWORKS Client Licensing Software
If the file server offers server-based licensing, and a sufficient number of
server-based licenses are available, the client computer needs no special
software for requesting and storing the Advanced Server license. However, if
the licenses are managed as client-based licenses, the client computer must
have PATHWORKS client licensing software to request and store Advanced
Server licenses.

The PATHWORKS client licensing software is automatically installed and
configured as part of the PATHWORKS client software installation procedure.
Therefore, if the client is running HP PATHWORKS 32, no additional client
licensing software is needed.
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If the client computer is not running PATHWORKS client software (for
example, on a retail Windows XP workstation), the PATHWORKS client
licensing software components (Client License Requester and Client License
Transponder) must be loaded and set up on the client computer to request and
store Advanced Server client-based licenses.

These client components are available on the file server system after you
install the file server software. For information about loading and customizing
the client software for client-based licensing, refer to the README.TXT file
provided with the Advanced Server PWLICENSE share on the file server.

Note

The PATHWORKS 32 system license PWXXWINAT07.nn:

• Grants the right to run the PATHWORKS 32 software on a client
system

• Is not required and does not grant the right to access a
PATHWORKS for OpenVMS (Advanced Server) or Advanced
Server for OpenVMS server

• Can be served to clients using the License Server, for
administrative purposes only

Note

The License Server included with the Advanced Server will not issue
or manage PATHWORKS for OpenVMS (NetWare) licenses. If you
have clients using NetWare networking software, maintain the existing
version of the License Server on a different system from the one that is
running Advanced Server.

1.1.4 Upgrading the License Server
No special upgrading procedures are required for installing a new version of
the License Server.

• If the system is running the integrated License Server, it is automatically
upgraded when you configure the new version of the file server.
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• If the system is running the standalone License Server, you can install the
new version of the License Server. You need not upgrade the file server.
Upgrade the License Server by simply installing and configuring it as
described in the Server Installation and Configuration Guide for your
Advanced Server product. No additional upgrade procedures are required
for standalone License Servers.

1.2 License Management Models
The file server requires that clients accessing file and print services be
appropriately licensed. To meet this requirement, one of the following must be
true:

• The client must have acquired a client-based license previous to
establishing a session with the file server.

• A server-based license must be available for each client establishing a
session with a file server without a client-based license.

In either case, the license required to access each version of the file server is
listed in Table 1–1, File Server Licenses.

Table 1–1 File Server Licenses

To access this file server . . .
The client needs this Client
Access license . . .

PATHWORKS for OpenVMS (Advanced Server) One of the following:
PWLMXXXCA06.00
PWLMXXXCA07.02
PWLMXXXCA07.03

Advanced Server V7.2 for OpenVMS One of the following:
PWLMXXXCA07.02
PWLMXXXCA07.03

Advanced Server V7.3B for OpenVMS PWLMXXXCA07.03

These licenses can be configured to be used as either client-based licenses, as
server-based licenses, or as a combination of both.

Clients currently using client-based licenses to access PATHWORKS V6 for
OpenVMS (Advanced Server) servers need not be changed. These clients will
continue to access PATHWORKS for OpenVMS (Advanced Server) servers
using their client-based license. However, to access the Advanced Server for
OpenVMS, they must obtain a new client-based license or a server-based
license must be available for them on the file server system.
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1.2.1 Server-Based License Management
Server-based licensing grants a specific number of clients connected to a file
server (on a first-come, first-served basis) the right to use server software on a
single server and allows clients access to file and print services resident on the
server.

1.2.1.1 When to Use Server-Based License Management
Server-based licensing is best suited for clients that need access to file and
print services on a single server, or for a large number of clients that need
occasional access to file and print services. Server-based licenses:

• Are consumed only for the duration of the session

• Are consumed only by clients without appropriate client-based licenses

• Require no license software on the client

• Use one server-based license for each server session

1.2.1.2 How Server-Based License Management Operates
On a file server that is not running the License Server, Client Access
licenses loaded into LMF are automatically used as server-based licenses.
From a license management point of view, this is the simplest form of
management and does not require use of the PATHWORKS client licensing
software, or performing management tasks with the License Manager.
License management consists of loading the appropriate Client Access PAKs
information into LMF on the file server node.

When a client connects to the file server, one server-based license is consumed
and the client is granted access to the file server. If there are no server-based
licenses available when the client requests a connection to the file server, the
connection request is denied.

After a server-based license has been used to grant a client access to a file
server, the client is licensed to access resources on that server until the client
disconnects from the file server.

When the client disconnects from the file server, the license assigned to that
client is released (except with Windows clients, as noted below), the number
of available server-based licenses is incremented, and the license becomes
available for another client.
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Note

In addition to the session that the client establishes when a share is
initially mapped, Windows client systems typically establish a second
session with the file server. This session uses a null (blank) user
name and connects to the IPC$ share. While this second session will
not cause the client to consume two server-based licenses, it might
prevent the client from releasing the server-based license when
the user disconnects all mapped drives. Use the ADMINISTER
SHOW SESSIONS command to view client sessions on the file
server. If necessary, terminate the client session, using the following
ADMINISTER command, where computer-name is the computer name
of the Windows NT client:

CLOSE SESSION computer-name

1.2.1.3 Server-Based License Management in an OpenVMS Cluster
When using server-based licenses for access to file and print services in an
OpenVMS Cluster environment, HP recommends that clients connect to the
cluster using the Advanced Server cluster alias, if this option is available.
Clients connecting using the alias consume one server-based license. Clients
connecting directly to specific cluster members consume one server-based
license for each connection to a different cluster member.

A client can map multiple drives and printers to a single server while
consuming a single server-based license.

1.2.2 Client-Based License Management
A client-based license is assigned on a per-workstation basis. A client-based
license for accessing OpenVMS file servers allows a client to access multiple
file servers with the single license. Client-based licenses are managed using
LMF, the License Server, and the License Manager.

After a client-based license has been assigned to a client, the license applies
only to that client until it is revoked or released. After a license has been
revoked, it is available for assignment by the License Server. To revoke a client
license, use the License Manager.

A license PAK is loaded in the LMF database on the system running the
License Server. The License Server assigns a client-based license upon request
for a license by a client. After the client receives the license, it is stored on the
client.
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1.2.2.1 How Client-Based License Management Operates
License management for client-based licenses consists of these types of client
activities:

• Obtaining licenses from a License Server when first started after
configuring Advanced Server license management

• Verifying licenses with the License Server each time the client boots after
the license has been assigned

• Presenting license information during the process of accessing file servers

These interactions require no specific actions on the part of a user once a client
is configured to use client-based license management.

1.2.3 Combining Server-Based and Client-Based License Management
You can use both server-based and client-based license management together
on one file server, allowing you greater flexibility.

Appropriate client-based licensing assures access to file servers. Clients that do
not have client-based licenses may access a file server if sufficient server-based
license capacity exists.

1.2.3.1 How Combined License Management Operates
In a combined-license environment, licenses are loaded in the LMF database
on the system running the file server and the License Server. Client Access
licenses loaded into LMF are automatically loaded by the License Server.
When the licenses are first loaded by the License Server, they are allocated
to the Default license group to be used as client-based licenses. The License
Manager allows you to allocate any number of these licenses to the Server-
Based license group so that they can be used for server-based licensing. The
remaining licenses, those in the Default group, or allocated to other license
groups, are managed as client-based licenses.

1.3 License Management Tasks
The Advanced Server licensing software includes the License Manager. This
software provides a user interface for system administrators to manage
licenses.

If the licensing environment consists of only server-based licensing, it is
not necessary to use the License Manager. When the licensing environment
includes client-based licensing, or a combination of client-based and server
based licensing, the License Manager is an invaluable tool for managing the
licensing software.
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The tasks you perform with the License Manager include:

• Manage PATHWORKS client software licenses, as well as Advanced Server
client-based licenses.

• Create and manage license groups that allow you to organize client-based
licenses into subsets called license groups, or simply groups. After you
organize licenses into separate groups, licenses in a particular group
are provided only to clients that identify themselves as members of the
designated groups.

For example, you could define three groups called Finance, Engineering,
and Sales. You could then place the number of licenses issued to a specific
organization into the groups bearing the organization’s name. This ensures
that their members can always acquire the licenses issued to them.

Note

To organize client-based licenses into groups, you must take additional
steps when configuring your client software. Specifically, you
must configure your clients to request a license from a particular
license group. See Chapter 5, Configuring Client Software, for more
information.

• Set alert levels that provide log entries in the License Server log file when
your supply of available client-based licenses goes below the set level. Use
this feature on a per-product basis and/or per-group basis.

• View the status of the client-based licenses that have been assigned.

• Revoke client licenses.

• Specify which License Server events to log in the License Server log file so
that you can obtain a better understanding of client license related activity.

• Add and remove product licenses from the license services database.

• Enable and disable the License Server.

• Generate reports of licenses assigned to clients.
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License management can be nearly transparent to both system administrators
and users. However, the License Manager provides optional capabilities that
allow you to configure your server in a way that best supports your computing
environment. This configuration may include client-based licensing, or a
combination of client-based and server-based licensing.

This chapter describes how to set up the Advanced Server for server-based
licensing, for client-based licensing, and for a combination of client-based and
server-based licensing. It also provides a set of examples of licensing setup.
In addition, this chapter includes information about configuration parameter
values in effect when the License Server and License Registrar are running.
All this information is presented in the following sections:

• Section 2.1, Setting Up Server-Based License Management, describes how
to configure server-based licensing.

• Section 2.2, Setting Up Client-Based License Management, describes how
to configure client-based licensing.

• Section 2.3, Setting Up Combined Client-Based and Server-Based License
Management, describes how to configure the license management to
support both server-based and client-based licensing.

• Section 2.4, Examples of Advanced Server License Management, provides
examples of license management configurations.

• Section 2.5, Upgrading Client Licenses, describes procedures for upgrading
client licenses.

• Section 2.6, License Server and License Registrar Configuration
Parameters, describes the License Server and License Registrar
configuration parameters.
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2.1 Setting Up Server-Based License Management
The simplest form of license management is a configuration that supports
only server-based licenses. Use the following steps to configure your Advanced
Server to support server-based licensing:

1. Acquire the appropriate license PAK — PWLMXXXCA06.00 or later for
PATHWORKS for OpenVMS (Advanced Server), or PWLMXXXCA07.03 for
Advanced Server for OpenVMS.

2. Register and load the license PAKs using the License Management Facility
(LMF) on the system where you will also be installing and running the file
server software. For information on the LMF database, refer to the HP
OpenVMS License Management Utility Manual.

3. Install, configure, and run the file server software. When you configure
the file server software, do not configure the file server to run the License
Server. In other words, follow these steps:

a. When you run the initial configuration procedure (PWRK$CONFIG.COM),
do not configure the Advanced Server to run the License Server.

b. Start the Advanced Server.

When the License Server is not configured to run with your file server, the file
server assumes that any Client Access licenses found on the system are to be
used as server-based licenses for licensing client access. After you start the file
server, unlicensed clients connecting to the file server will be licensed without
any further setup or configuration.

2.1.1 Setting Up Server-Based Licensing Only, for Performance Gains
Optionally, you can configure server-based licensing only, for per-
formance purposes. To do so, uncomment the following line in the
PWRK$LICENSE_R_START.COM file if it is commented as:

$! Define_sys PWRK$Lr_Disable_Client_Ping 1 ! Disable Client
license checking

If this logical is not defined or given the default value of 0, even if only server-
based licensing is configured, the License Registrar first checks whether a
client attempting to connect to the file server has a valid client-based license.
Defining this logical with a nonzero value, as in the example, prevents the
License Registrar from checking for a client-based license. Instead, it attempts
immediately to assign a server-based license. This can improve performance.
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This logical does not affect or change the number of licenses assigned to the
server-based group, the default client-based license group, or any user-defined
license groups.

Note

With this setup the client-based license of any connecting client is
ignored. If you do not use client-based license on your network, then
the above setup is the preferred configuration.

2.2 Setting Up Client-Based License Management
For a configuration that supports client-based licensing, there are additional
steps required for setting up the system. This configuration requires the use of
the License Server and loading client software. If you decide to configure the
OpenVMS system to run the License Server, the default is to allocate all Client
Access licenses on the system as client-based licenses.

Follow these steps to support client-based licenses:

1. Acquire the appropriate license PAK — PWLMXXXCA06.00 or later for
PATHWORKS for OpenVMS (Advanced Server), or PWLMXXXCA07.03 for
Advanced Server for OpenVMS.

2. Identify the system to be used as the License Server system.

3. Register and load the related PAKs in the LMF database on any License
Server on the network. For information on the LMF database, refer to the
HP OpenVMS License Management Utility Manual.

4. Install and configure the License Server software using the normal
installation and configuration process for the server. You can install the
License Server software on the same system as a file server, or you can
install it as a standalone License Server on a different system. The License
Server normally puts only a very small additional load on a system. For
more information on how to load and configure License Servers, refer to
the Server Installation and Configuration Guide for your Advanced Server
product.

5. Start the License Server. (If your License Server is configured on the same
system where your file server is configured, the License Server starts when
you start the file server.) For information about how to enable the License
Server to start when the file server starts, refer to the Server Installation
and Configuration Guide for your Advanced Server product.
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6. Invoke the new License Manager user interface using the following
command:

$ ADMINISTER/LICENSE

Using the License Manager, create any desired user-defined license groups
and allocate licenses to these license groups. (For information about using
License Manager to perform these tasks, see Section 4.6, Performing
License Group Tasks.) By default, all Client Access licenses will be
client-based licenses in the Default group.

Allocate the number of licenses you want to use as server-based licenses
to the Server-Based group. This reserves the specified number of licenses
for use by the file server as server-based licenses. The number you allocate
to the Server-Based license group will not be available as client-based
licenses.

7. Install and configure the PATHWORKS client licensing software on clients
that will be using client-based licenses:

• For clients using PATHWORKS client software (for example,
PATHWORKS 32), the client configuration procedure includes all
the software and components necessary for clients to fully participate
in the Advanced Server license management process.

Depending on configuration or licensing needs, additional configuration
steps might be required. Refer to your PATHWORKS client product
documentation for more information.

• For non-PATHWORKS clients using client-based licensing, the
PATHWORKS client licensing software must be loaded on the client
before it can participate in the license management process. For
details, refer to the README.TXT file provided in the PWLICENSE
share on the file server.

8. Restart the client. During the restart, the client searches for a License
Server to acquire the required license.
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2.3 Setting Up Combined Client-Based and Server-Based
License Management

For a configuration that supports both client-based and server-based licensing,
you must use the License Manager to specify how many licenses are to be used
as server-based and how many are to be used as client-based.

Follow these steps to configure the License Server to support both client-based
and server-based licensing:

1. Identify the file server system to be used as the License Server.

2. Register and load the related PAKs in the LMF database on the system
chosen as the License Server. For more information about how to load
PAKs in the LMF database, refer to the HP OpenVMS License Management
Utility Manual.

3. Install and configure the Advanced Server software using the normal
installation and configuration process for the server. For more information
about how to install and configure License Servers, refer to the Server
Installation and Configuration Guide for your Advanced Server product.

4. Start the file server. For information about how to start the server, refer to
the Server Installation and Configuration Guide for your Advanced Server
product. By default, all licenses will be client-based licenses.

5. Use the License Manager to configure the server-based licenses required.
Use the License Manager to allocate the desired number of server-based
licenses from the Default group to the Server-Based group. Licenses
allocated to the Server-Based license group are reserved for use as
server-based licenses and cannot be assigned to clients by the License
Server.

For more information on how to configure server-based licenses, see
Section 4.6, Performing License Group Tasks.

6. Install and configure the client software on clients that will be using
client-based licenses:

• For clients using PATHWORKS client software (for example,
PATHWORKS 32), the client configuration procedure includes all
the software and components necessary for clients to fully participate
in the license management process.

Depending on configuration or licensing needs, additional configuration
steps might be required. Refer to your PATHWORKS client product
documentation for information.
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• For non-PATHWORKS clients, license management software must be
loaded on the client before it can participate in the Advanced Server
license management process. For details, refer to the README.TXT
file provided in the Advanced Server PWLICENSE share on the file
server.

2.4 Examples of Advanced Server License Management
The following examples provide step-by-step instructions for using Advanced
Server licensing software and PAKs.

2.4.1 Setting Up Client-Based Licensing in a LAN
Configuration:

• The file server is running the Advanced Server in a LAN. The License
Server is on the file server system.

• Clients have supported version of Microsoft Windows software already
installed.

Components:

• Advanced Server for OpenVMS media and documentation kit.

• A PAK for 750 Advanced Server for OpenVMS Client Access (CA) licenses
(PWLMXXXCA07.03).

Procedure:

Step Action

1. Register and load PAKs into the License Management Facility (LMF) on the
system that will run the License Server. Follow the instructions provided in
the HP OpenVMS License Management Utility Manual.

2. Install and configure Advanced Server for OpenVMS software on one or
more systems following the instructions found in the HP Advanced Server for
OpenVMS Server Installation and Configuration Guide. Make sure you enable
the License Server when configuring the Advanced Server for OpenVMS on
the node that will run the License Server.

3. Start the Advanced Server on the node where the License Server is enabled.
Using the License Manager, optionally create license groups and allocate
licenses to each client group as described in Chapter 4, Managing Licenses on
the OpenVMS Platform.
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Step Action

4. Load PATHWORKS client license software on the clients and configure them
as described in the README.TXT file provided with the Advanced Server
PWLICENSE share on the file server. Clients are running Microsoft LAN
Manager software and can access the file servers.

5. Restart the newly configured clients.

2.4.2 Setting Up Combined Client-Based and Server-Based Licensing
in a WAN

The following example demonstrates how to set up a License Server to support
client-based and server-based licensing in a WAN.

Configuration:

• The file server is running the Advanced Server for OpenVMS product, and
the License Server is running on the file server system.

• Some clients are running Windows 2000 and Windows XP client software.

• Some clients are running PATHWORKS 32 client software.

• Some clients have client licensing software and will request client-based
licenses.

• Some clients do not have client license software; they will require server-
based licensing.

Components:

• Advanced Server for OpenVMS media kit and documentation.

• PATHWORKS 32 media kit and documentation.

• A PAK for 125 Advanced Server for OpenVMS Client Access (CA) licenses
(PWLMXXXCA07.03).

• A PAK for PATHWORKS 32 client software (PWXXWINAT07.01), to grant
the right to run the PATHWORKS 32 client software.
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Procedure:

Step Action

1. Choose a system to run the License Server. On the License Server system,
register and load PAKs into the License Management Facility (LMF). Follow
the instructions provided by the HP OpenVMS License Management Utility
Manual.

2. Install and configure Advanced Server for OpenVMS software on the file
server system following the instructions found in the HP Advanced Server
for OpenVMS Server Installation and Configuration Guide. Make sure you
run the License Server when configuring the Advanced Server for OpenVMS
software on the node that will run the License Server.

3. Start the License Server and the file server.

4. Appropriately install and configure the client software. For information about
procedures, refer to the README.TXT file provided with the Advanced Server
PWLICENSE share on the file server.

5. Restart the newly configured clients.

6. Use the License Manager to allocate sufficient licenses to the Server-Based
group to support server-based licensing.

Clients requesting assignment of a client-based license will obtain client-based
licenses and others will use server-based licenses.

2.4.3 Setting up a V6 Server to Allow Clients to Request PATHWORKS
V5 for OpenVMS (LAN Manager) Licenses

The following example demonstrates how to configure the License Server so
that clients can use PATHWORKS V5 for OpenVMS (LAN Manager) licenses.

Configuration:

• The file server is already running PATHWORKS V5 for OpenVMS (LAN
Manager). The License Server is not running on the file server system.

• A License Server is running standalone using PATHWORKS V5 for
OpenVMS (LAN Manager) software, which will be upgraded to use
PATHWORKS V6.1 for OpenVMS (Advanced Server) software.

• Clients are using PATHWORKS V6.0 for DOS and Windows software.
They have PATHWORKS V6.0 for DOS and Windows CCS licenses
(PWLMDOSCC06.00).
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Components:

• PATHWORKS V5 for OpenVMS (LAN Manager) media and documentation
kit (already installed on both the file server system and the standalone
License Server system).

• PATHWORKS V6.1 for OpenVMS (Advanced Server) media and
documentation kit.

• PATHWORKS V6.0 for DOS and Windows media and documentation kit.

• A PAK for 500 PATHWORKS V6.0 for DOS and Windows (LAN Manager)
CCS licenses (PWLMDOSCC06.00) already registered and loaded on the
standalone License Server system.

Procedure:

Step Action

1. Upgrade the standalone License Server software by installing and configuring
the PATHWORKS V6.1 for OpenVMS (Advanced Server) software on the
License Server system. During the installation procedure, specify that you
do not want to install the PATHWORKS V6.1 for OpenVMS (Advanced
Server). Then specify that you do want to install the standalone License
Server software.

2. Start the License Server. Licenses that were previously served by the License
Server running the PATHWORKS V5 for OpenVMS (LAN Manager) software
will continue to be available and be served using the PATHWORKS V6.1 for
OpenVMS (Advanced Server) software. In addition, if the client access licenses
(PWLMXXXCA06.00) are purchased, they can be registered and loaded on the
License Server system and be served to clients requesting them.

2.4.4 Using Server-Based Licensing in a LAN or WAN
The following example demonstrates how to set up server-based licensing in a
LAN or WAN.

Configuration:

• The file server is running Advanced Server for OpenVMS.

• The License Server is not running on the same system that the file server
is running on.

• Clients have Microsoft Redirector software already installed.

• All clients use Advanced Server for OpenVMS Client Access (CA) licenses
(PWLMXXXCA07.03) as server-based licenses.
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Components:

• Advanced Server for OpenVMS media and documentation kit.

• A PAK for 180 Advanced Server for OpenVMS Client Access (CA) licenses
(PWLMXXXCA07.03).

Procedure:

Step Action

1. Register and load the PAKs in the License Management Facility (LMF) on the
system where the Advanced Server will be used.

2. Install, configure, and run the Advanced Server for OpenVMS software. Do
not configure the License Server software for this system.

2.5 Upgrading Client Licenses
If you are upgrading the file server from one version to the next, note the
following:

1. Any client accessing a new version of the file server must be sufficiently
licensed for access; unlicensed clients or clients without a sufficient level of
licensing will not be allowed access.

2. A higher-level license is required to access the new file server than is
required to access the previous version of the file server.

The license required depends on the version of the server that the clients need
to access, as listed in Table 1–1, File Server Licenses.

Note

If you use Advanced Server for OpenVMS licenses (PWLMXXXCA07.03),
clients can access both Advanced Server for OpenVMS servers and
PATHWORKS V6 for OpenVMS (Advanced Server) servers.
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When you plan the migration of the file server, assess the environment and
decide the best procedure to ensure that clients who need to access the file
server are sufficiently licensed. Upgrade procedures for client-based licenses
are described in the following sections:

• Section 2.5.1, Configuring Client License Upgrades Individually

• Section 2.5.2, Replacing All Licenses

• Section 2.5.3, Upgrading Client Licenses Automatically

2.5.1 Configuring Client License Upgrades Individually
Individually configuring specific clients to request a new license requires
modifying the client configuration for the licenses the client requests. This
procedure works best when:

• There are very few clients that will access the new version of the file server.

• Migration of clients to using the new version of the file server will be slow
and done over a long period of time.

The procedure for configuring clients individually is described in the
README.TXT file provided with the Advanced Server PWLICENSE share
on the file server.

2.5.2 Replacing All Licenses
This procedure works best if you choose to remove all the old licenses from
the License Server system. If some old licenses are still needed on the License
Server system, in addition to new Client Access licenses, set up automatic
license upgrading, as described in Section 2.5.3, Upgrading Client Licenses
Automatically.

If new licenses have been loaded onto the License Server system, the License
Server, through normal license version look-up procedures, will not find an old
license, but will find a new license and assign it to the client instead. For a
discussion of how license lookup works, see Section 3.3, Controlling License
Version Lookup.

If the old license PAKs are removed from the License Server system, all clients
that had previously been assigned licenses by this server will automatically
have their licenses revoked. The next time these clients attempt to verify their
licenses, they will be informed that their previously assigned license is now
invalid. The client license requester will automatically attempt to acquire a
new license. (Some older client license requesters may need to be manually
run again to request a new license.)
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2.5.3 Upgrading Client Licenses Automatically
By default, the License Server will not perform license upgrades. You can
configure a License Server to upgrade licenses automatically. For example,
if configured appropriately, the License Server will automatically upgrade a
PATHWORKS V5 for OpenVMS (LAN Manager) client license request or a
PATHWORKS V6 Advanced Server license request to an Advanced Server for
OpenVMS (PWLMXXXCA07.03) license. Follow this procedure to enable the
License Server to upgrade licenses automatically:

1. Load new license PAKs on the License Server.

2. Edit the License Server start-up command file
SYS$STARTUP:PWRK$LICENSE_S_START.COM to include the
appropriate logical name definition, depending on which licenses will
be available:

License PAK Logical Name Definition

PWLMXXXCA06.00

$ DEFINE/SYSTEM PWRK$LS_V6_ACCESS_UPGRADE 1

PWLMXXXCA07.03

$ DEFINE/SYSTEM PWRK$LS_V7_ACCESS_UPGRADE 1

Be sure to define the logicals before the following RUN command:

$ RUN SYS$SYSTEM:PWRK$LICENSE_SERVER

If a logical name is disabled (undefined or defined to be zero), the License
Server will not automatically upgrade licenses to the appropriate new license.
If the logical name is defined to the value 1 (or any numeric value other than
zero), clients requesting assignment or verification of licenses will have their
licenses upgraded automatically to new licenses, if sufficient new licenses exist.
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Note

The PWLMXXXCA07.02 and PWLMXXXCA07.03 licenses are
recognized by PATHWORKS (LAN Manager) V5.0F servers and later
versions of V5. Clients presenting this license to an earlier version of
PATHWORKS (LAN Manager) will be denied access.

If you define the PATHWORKS V6 Advanced Server logical
PWRK$LS_V6_ACCESS_UPGRADE, read the documentation in
the License Server startup file about the interaction between this
logical and the PWRK$LS_V7_ACCESS_UPGRADE logical.

If you only define the V6 logical, PWLMXXXCA06.00 licenses are
assigned before assigning PWLMXXXCA07.02 or PWLMXXXCA07.03
licenses.

If you want to remove all PWLMXXXCA06.00 and PWLMXXXCA07.02
licenses so that you only have PWLMXXXCA07.03 licenses, or if all
units of a PWLMXXXCA06.00 license are consumed, the License
Server will assign a PWLMXXXCA07.02 license first, if available. If
no PWLMXXXCA07.02 licenses are available, then it will assign a
PWLMXXXCA07.03 license, if available. Remember that to access the
Advanced Server V7.3B for OpenVMS, a PWLMXXXCA07.03 license is
required.

The first time the License Server is started after an upgrade, the License
Server state file will be modified to remove all old licenses from the Server-
Based license group that do not provide access to the current file server. (The
state file keeps track of licenses that are loaded, groups that are created, and
licenses assigned to each group.) The Advanced Server License Server still
assigns and verifies client-based licenses.

When an upgrade operation occurs, the License Server logs both the
assignment of the new license and the name of the license returned to the
client in the License Server log file
PWRK$LOGS:PWRK$LICENSE_SERVER_node-name.LOG. This license
returned to the client is called a virtual license, as described in Section 2.5.4,
Virtual Licenses.

Configuring the License Server to automatically upgrade old license requests
affects all clients requesting or verifying a license. If the License Server
is configured to automatically upgrade licenses, client-based licenses are
upgraded to new licenses when either of the following occurs:
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• A client requests assignment of an old license.

• A client requests verification of a previously assigned license.

The License Server automatically assigns the client a new license (even if it
has requested assignment or verification of an old license), and returns an
equivalent new license to the client.

2.5.4 Virtual Licenses
Before the introduction of Client Access (CA) licenses, the file server required
older style licenses (such as FP or CC licenses). Requests for these older style
licenses will be upgraded properly. However, the client will only accept licenses
of the type requested with the requested version number or higher. To get the
client to accept a Client Access license, the License Server returns a different
name than that assigned.

If a client requests an earlier form of the PATHWORKS license (such as FP
or CC licenses), the upgrade returns a ‘‘virtual license,’’ that is, an equivalent
Client Access license with a name that does not match the name of the license
assigned to the client.

For example, if a client requests assignment of a PWLMXXXFP05.00 license
from the License Server, the License Server upgrades the request to a Client
Access license and assigns a new license (if one is available).

From the client’s perspective, the license assigned is PWLMXXXFPmm.nn and
the client will accept that. The symbols mm.nn represent any valid license
version number. From the License Server’s perspective (as displayed by the
License Manager), the client was assigned a PWLMXXXCAmm.nn license.
Table 2–1, Virtual License Names, lists the names of the licenses returned to
clients due to upgrade operations.

Table 2–1 Virtual License Names

License Requested

License Assigned
by PATHWORKS for
OpenVMS (Advanced
Server) or Advanced
Server for OpenVMS

License Returned by PATHWORKS
for OpenVMS (Advanced
Server) or Advanced Server
for OpenVMS

PWLMDOSCCnn.mm PWLMXXXCA06.00 PWLMDOSCC07.00

PWLMDOSCCnn.mm PWLMXXXCA07.02 PWLMDOSCC07.02

(continued on next page)
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Table 2–1 (Cont.) Virtual License Names

License Requested

License Assigned
by PATHWORKS for
OpenVMS (Advanced
Server) or Advanced
Server for OpenVMS

License Returned by PATHWORKS
for OpenVMS (Advanced
Server) or Advanced Server
for OpenVMS

PWLMDOSCCnn.mm PWLMXXXCA07.03 PWLMDOSCC07.03

PWLMWNTCCnn.mm PWLMXXXCA06.00 PWLMWNTCC07.00

PWLMWNTCCnn.mm PWLMXXXCA07.02 PWLMWNTCC07.02

PWLMWNTCCnn.mm PWLMXXXCA07.03 PWLMWNTCC07.03

PWLMXXXFPnn.mm PWLMXXXCAnn.mm PWLMXXXFPnn.mm

When the license assigned is different from the license returned to the client,
the License Server log file contains two messages:

• One message indicates the name of the license assigned to the client.

• The other message indicates the name of the license returned to the client.

2.6 License Server and License Registrar Configuration
Parameters

When the License Server and License Registrar run, complete descriptions
of the configuration parameters used by these processes are contained in the
following command procedures:

• SYS$STARTUP:PWRK$LICENSE_S_START.COM

• SYS$STARTUP:PWRK$LICENSE_R_START.COM

For descriptions of the License Registrar configuration parameters and the
logicals that determine their values, see Section A.3, License Registrar Events.

As part of their startup sequence and announcement, the License Server
and License Registrar place tables of their configuration parameters in their
respective log files related to license processing:

• PWRK$LOGS:PWRK$LICENSE_SERVER_servername.LOG, where
servername is usually the OpenVMS Cluster alias or the node name of the
system on which the License Server runs

• PWRK$LOGS:PWRK$LICENSE_REGISTRAR_nodename.LOG, where
nodename is the node name of the system (the file server) on which the
License Registrar runs
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For each parameter in the table, the following information is recorded:

• Parameter name

• Parameter type

• Whether the parameter is dynamic

• The current value being used

• Whether that value is the default value for the parameter

2.6.1 Dynamic Configuration Parameters
Dynamic configuration parameters allow the value of a parameter to be
changed using a system logical, without having to restart the Advanced Server
for OpenVMS. The license component that uses the parameter obtains the
changed value while the component is running.

When the value of a dynamic configuration parameter is changed by redefining
the control logical associated with the configuration parameter, the change
might not take effect immediately. The license components periodically check
the values of their dynamic configuration parameters to see if the value of
any parameter has changed. When the license component detects a change
to the value of a dynamic configuration parameter, a message is recorded in
the component’s log file when the new value is put into use. By default, the
components check for changes to dynamic parameter values every 10 minutes.
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Configuring License Servers

This chapter explains some License Server configuration changes you may
need to make and the impact of those changes on the client(s). The License
Server configuration information is explained in the following sections:

• Section 3.1, License Server State Files, describes the contents of the
License Server state file and describes how to create a new one.

• Section 3.2, Moving a License Server to a Different System, describes the
options available to you when you move the License Server to a different
node.

• Section 3.3, Controlling License Version Lookup, describes how to control
the ‘‘look-ahead’’ function of the License Server.

• Section 3.4, Controlling Where the License Server Runs in an OpenVMS
Cluster, describes different configuration options that are available to
control which system the License Server runs on in an OpenVMS Cluster
environment.

• Section 3.5, Synchronizing the License Server Database with the LMF
Database, describes how the database is synchronized with the LMF
database updates that have occurred.

3.1 License Server State Files
The License Server stores information in a database called the License Server
state file, which exists on the system as:

PWRK$LICENSE:PWRK$LICENSE_SERVER_STATE.DAT

The information that is stored in the License Server state file includes the
following:

• The name used by the License Server that enable clients to access it

• Information about the types and quantities of client-based licenses that are
available to assign to clients
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• License group information

• A record of the licenses the License Server has assigned to clients

The following sections provide information about the License Server state file
and describe the procedure for recreating it.

3.1.1 License Server Name
The License Server state file stores the name of the License Server. This name
is used to facilitate communication between the License Server and clients.
When a client is assigned a license, part of the license information saved by
the client is the name of the License Server that issued the license. This name
is used to contact the License Server when the client attempts to verify its
licenses. The name is defined in the following format:

PWRK$Lname

When the License Server is started for the first time, the template License
Server state file provided during installation does not contain the License
Server name. The License Server determines its name as follows:

• On a node in an OpenVMS Cluster, where an equivalence-name is defined
for the logical SYS$CLUSTER_NODE, the node name portion of the value
of the equivalence-name is used as the name portion of the License Server
name.

• On a standalone node, where the logical SYS$CLUSTER_NODE is not
defined, the License Server uses the value of the SYSGEN SCSNODE
parameter as the name portion of the License Server name.

In either case, the value chosen as the name portion of the License Server
name is used to form the License Server name, which is then stored in the
License Server state file. Once established, the License Server uses the name
stored in the state file, even if the SYS$CLUSTER_NODE or SCSNODE values
should change.

3.1.2 Creating a New License Server State File
If the License Server state file is rendered unusable, the License Server will
not run. You must create a new License Server state file if this happens.
Follow these steps to create a new License Server state file:

1. Shut down the License Server.

In a cluster, shut down the License Server on all nodes.

2. If the License Server state file exists, delete the current License Server
state file, or rename it to another filename.
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In a cluster, do this on only one node because the state file is common to all
nodes.

3. Restart the License Server.

When the License Server starts and does not find a License Server state
file, it creates a new state file and logs a message to the License Server
log file stating that a new state file has been created and that the License
Server has disabled itself.

4. To enable the License Server:

a. Invoke the License Manager.

b. From the Main menu, choose Options.

c. From the Options menu, choose Server Enable/Disable.

d. Choose Enable Server.

e. Choose OK.

Once enabled, the License Server determines its name and initializes the
License Server state file before it responds to any client requests. See
Chapter 4, Managing Licenses on the OpenVMS Platform, for information
about using the License Manager.

Because the License Server begins running with a new License Server state
file, all information from any previous License Server state file is lost, including
the License Server name, any group information, and all records of client
licenses that were previously assigned. If license groups were being used, you
must recreate the groups and allocate licenses to them.

When the License Server starts with the new state file and determines its
name, two possible problems can occur:

• The License Server name is the same name as was previously used, but
license groups are not defined.

In this case, any client that was previously assigned a license by the
License Server fails on its next attempt to verify the license, because the
assignment information stored in the previous state file was lost and the
client’s license is marked as invalid. In this case, the client should attempt
to acquire a new license after you recreate the licensing groups.

• The License Server name is different than the name previously used, but
the client license data file is not updated.
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In this case, clients cannot locate the License Server to verify their license
because they are attempting to contact the License Server using the
License Server’s old name. You should delete the license data file on the
client and reboot it so that it attempts to acquire a new license. If the
licensing configuration template file specifies a License Server name, the
configuration file must be changed. Then, when the client looks for a new
license, it finds its new name, and it can acquire a new license.

3.2 Moving a License Server to a Different System
There are two recommended methods for changing the system on which the
License Server is run. You can move the License Server and retain the same
server name or you can move the License Server and change the server name.

When you move the License Server and retain the server name, it is
transparent to users. Clients will not notice that the License Server has
moved.

When you move the License Server and change the server name, there is an
impact on both server administration and clients:

• You must reenter all license group information on the new system using
the License Manager and you must allocate licenses to each of the groups.

• You must keep the original License Server running (even though it does not
have any licenses it can assign) until all the clients find the new License
Server.

• The original License Server revokes client licenses so clients can request
assigned licenses from the new server.

Use the following procedures for moving the License Server and retaining the
server name or moving the License Server and changing the server name.

3.2.1 Moving the License Server and Retaining the License Server
Name

For the purposes of this example, the License Server is currently running on a
system called SYS1, and the License Server is to be moved to a system called
SYS2, which is not currently running a License Server.

1. Shut down the License Server on SYS1.

2. Reconfigure the file server on SYS1 so that the License Server is not
started when the file server is started.

3. Unload and delete all the client-based license PAKs from LMF on SYS1.
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4. Register and load all the client-based license PAKs that were deleted from
LMF on SYS1 into LMF on SYS2.

5. Install the file server software on SYS2, if not already done.

6. Configure the file server on SYS2 to run the License Server, but do not
start the License Server.

7. Delete any template License Server state files on SYS2. For more
information, see Section 3.1, License Server State Files.

8. Copy the License Server state file from the PWRK$LICENSE directory on
SYS1 to the PWRK$LICENSE directory on SYS2.

9. Start the License Server on SYS2. The License Server finds and reads the
License Server name it was previously using on SYS1 in the state file and
continues to use them while running on system SYS2.

Clients that were assigned licenses by the License Server running on SYS1
continue to verify their licenses (or get new licenses) from the License
Server named ‘‘SYS1’’ running on system SYS2.

3.2.2 Moving the License Server and Changing the License Server
Name

For the purposes of this example, the License Server is currently running on a
system called SYS1, and the License Server is to be moved to a system called
SYS2, which is not currently running a License Server.

1. Install the file server on SYS2, if not already done.

2. Configure the file server on SYS2 to run the License Server, but do not
start the License Server.

3. Shut down the License Server on SYS1.

4. Unload and delete all the client-based license PAKs from LMF on SYS1.

5. Register and load all the client-based license PAKs that were deleted from
LMF on SYS1 into LMF on SYS2.

6. Start the License Server on SYS2, causing the License Server on SYS2
to form the License Server name using ‘‘SYS2’’ as the node portion of the
License Server name. The new name is stored in the License Server state
file on SYS2.

7. Using the License Manager, load the licenses into the License Server and
define any groups that were defined for the License Server on SYS1. This
recreates a similar License Server state file on SYS2 as was on SYS1,
with the exception of the client licenses assigned on SYS1. See Chapter 4,
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Managing Licenses on the OpenVMS Platform, for information about how
to use the License Manager.

8. Start the License Server on SYS1, causing the License Server on SYS1
to synchronize the count of assignable licenses with LMF. Because all the
client-based licenses have been removed from LMF, all licenses previously
assigned by the License Server on SYS1 are automatically revoked.

9. Leave the License Server on SYS1 running until all clients who were
issued licenses by the License Server on SYS1 discover their licenses have
been revoked. Notification that the license has been revoked and is invalid
occurs when clients boot and attempt to verify their license. After a client’s
license is revoked, the SYS2 License Server can assign a new license.

It may be necessary to modify the client configuration if the License Server
name SYS1 was specified.

3.3 Controlling License Version Lookup
If there are no available licenses for the version of the server that the client
requests, the licensing software looks for a license for a higher version.

By default, the software looks for licenses for subsequent major and minor
releases up to 4.3 versions beyond the requested version.

For example, if the request is for Version 5.1, and no licenses are available, the
License Server looks for the following license versions in the LMF database:

5.2, 5.3, 5.4
6.0, 6.1, ..., 6.4
7.0, 7.1, ..., 7.4
8.0, 8.1, ..., 8.4
9.0, 9.1, ..., 9.4

You control the version limits by defining the following logical name in the
systemwide logical name table before starting the licensing software:

PWRK$LICENSE_VERSION_LIMIT

You can define the logical name in two different formats:

"+MM.mm"
"MM.mm"

For MM substitute the major release number; for mm substitute the minor
release number. The + means that the version is incremental. For example,
the highest version searched is the current version plus the incremental
version. Without the +, the release number is the absolute value and the
search ends at the specified version.
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Example 1:

$ DEFINE/SYSTEM PWRK$LICENSE_VERSION_LIMIT "+1.3"

In this example, the license software looks for licenses for one major release
beyond the requested version, and for licenses for three point releases beyond
the requested minor release version. If the request is for Version 5.1, and no
licenses are available, the License Server or License Registrar looks for licenses
in the LMF for the following versions:

5.2, 5.3, 5.4
6.0, 6.1, 6.2, 6.3, 6.4

Example 2:

$ DEFINE/SYSTEM PWRK$LICENSE_VERSION_LIMIT "6.2"

In this example, the license software looks for licenses for major software
versions up to and including Version 6, and for licenses for point releases up to
and including .2. If the request is for Version 5.1, and no licenses are available,
the License Server or License Registrar looks for licenses in the LMF for the
following versions:

5.2
6.0, 6.1, 6.2

3.3.1 Acquiring a Different Client-Based License than Requested
In the case where a client is attempting to acquire a client-based PATHWORKS
for OpenVMS (Advanced Server) license and no PATHWORKS for OpenVMS
(Advanced Server) licenses are available on the local system, the license lookup
function may find an Advanced Server for OpenVMS license for the client if one
is available. (Advanced Server for OpenVMS licenses are valid for accessing
both PATHWORKS for OpenVMS (Advanced Server) servers and Advanced
Server for OpenVMS servers.)

• If the License Server determines that no PATHWORKS for OpenVMS
(Advanced Server) licenses are available, the License Server will
begin the lookup process again, looking for Advanced Server licenses
(PWLMXXXCAnn.mm).

• If the License Server finds an available Advanced Server license, it is
assigned to the client and a virtual license is returned to the client.
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3.4 Controlling Where the License Server Runs in an
OpenVMS Cluster

Installing the License Server in an OpenVMS Cluster environment provides
license service failover in the event that license services terminate on the node
running the active License Server.

Normally, the License Server process (PWRK$LICENSE_S) is started on every
node of the OpenVMS Cluster that starts the file server, but only one License
Server process is active at any one time. The other License Server processes
remain dormant until an event, such as system shutdown or a system failure,
causes the active License Server process to stop. When the active License
Server stops, one of the dormant License Servers becomes active and continues
to provide license services to clients.

In most cases, HP recommends that you run the License Server on all nodes of
the cluster that run the file server, for maximum availability. The exception is
the case where the License Server will serve licenses to WAN clients. Then you
will want to limit the License Server to running on one node of the cluster.

In an OpenVMS Cluster environment, the License Server state file
is maintained cluster-wide. The file server directory tree starting at
PWRK$ROOT must be on a disk that is common to all nodes on the OpenVMS
Cluster.

There are a number of ways to determine which node is running the active
License Server:

• Use the SHOW SYSTEM command.

This command displays status information about current processes
running on your system. The active License Server process is listed as
PWRK$LICENSE_S with the state listed as HIB as shown in the following
example:

$ SHOW SYSTEM
Pid Process Name State Pri I/O CPU Page

.

.

.
00000230 PWRK$LICENSE_S HIB 6 191 0 00:00:01.67 777

.

.

.
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This example shows only the License Server process. A dormant License
Server is shown with its state indicated as LEF. When you enter the
SHOW SYSTEM command, all of the currently running processes on the
system are displayed.

• Use the PWSHOW command.

This is one of many commands that provide shortcuts for invoking
certain server management commands and procedures. You can
see a list of these commands by examining the contents of the file
SYS$STARTUP:PWRK$DEFINE_COMMANDS.COM. To define these
commands so that you can use them at login, refer to the Server
Installation and Configuration Guide for your Advanced Server product.

The PWSHOW command displays information about file server processes
that are running on the system. The information is displayed in the same
format that the SHOW SYSTEM command produces.

The PWSHOW command accepts arguments to show processes on a specific
node in a cluster and to show all nodes in a cluster as follows:

The PWSHOW CLUSTER command shows all file server processes
running on each node in the OpenVMS Cluster.

The PWSHOW NODE nodename command shows the Advanced Server
processes running on system nodename in the OpenVMS Cluster.

This command is available after you invoke the PWRK$DEFINE_
COMMANDS command procedure. To invoke this command procedure,
enter the following command:

@SYS$STARTUP:PWRK$DEFINE_COMMANDS.COM

• Start the License Manager on a node that is not running the License
Server and an error message states that the server is running on the
nodename system. The License Manager must be run on the same node as
the active License Server.

For example, enter the command ADMIN/LICENSE. If the License Server
is not running on that node, the message shown in Figure 3–1, License
Server Startup Error Message, appears.

• Look in PWRK$LOGS.
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Figure 3–1 License Server Startup Error Message

VM-0023A-AI

ERROR

License Server is running on node 'ALPHA'

Continue

The latest file that matches PWRK$LICENSE_SERVER_OpenVMS-cluster-
name.LOG is produced by the active License Server and displays the
message:

License Server cluster-alias is now processing LAN Manager
license requests on node active-node

(The OpenVMS-cluster-name may not be a cluster name, although it most
likely is one.)

You use the TYPE or SEARCH commands to examine the file while it is
still open.

3.4.1 How to Specify Where License Servers Run in a Cluster
To prevent the License Server from running on a particular node, you can add
the following logical name definition to that node’s startup command procedure:

$ DEFINE/SYSTEM PWRK$LICENSE_SERVER_INHIBIT 1

Note

In a cluster environment where all nodes use the same startup
procedure, check the node name before executing the DEFINE
command.

The SYS$STARTUP:PWRK$LICENSE_S_START.COM file has information
about this logical. The initial value of this logical (and its only value, as it does
not define a dynamic parameter) is logged in the License Server log file
PWRK$LOGS:PWRK$LICENSE_SERVER_servername.LOG.

3–10 Configuring License Servers



Configuring License Servers
3.4 Controlling Where the License Server Runs in an OpenVMS Cluster

Note

The Advanced Server for OpenVMS License Server interprets the
value associated with the PWRK$LICENSE_SERVER_INHIBIT
configuration parameter in the same manner as does the PATHWORKS
V6 for OpenVMS server.

This is different from the way a PATHWORKS V5 for OpenVMS server
interprets it. Under PATHWORKS V5 for OpenVMS, a value of zero
for this parameter indicates that the License Server will be prevented
from running on the local node. With Advanced Server for OpenVMS,
the configuration parameter value is interpreted as follows:

• A value of one means TRUE, which prevents the License Server
from running.

• A value of zero means FALSE, which allows the License Server to
run.

The following example shows how to prevent the License Server from running
on node SPOT:

$ IF F$TRNLNM("SYS$NODE") .EQS. "SPOT::" THEN -
DEFINE/SYSTEM PWRK$LICENSE_SERVER_INHIBIT 1

The next example shows how to allow the License Server to run only on node
ROVER:

$ IF F$TRNLNM("SYS$NODE") .NES. "ROVER::" THEN -
DEFINE/SYSTEM PWRK$LICENSE_SERVER_INHIBIT 1

You can specify the following logical name definition to define which nodes you
want the License Server to run on. By default, if this logical is not defined, the
License Server will run on all nodes.

$ DEFINE/SYSTEM PWRK$LS_LICENSE_NODES "node1, node2, node3"

Each node name that you add to this comma-separated list is a node that is
allowed to run the License Server. Any node in your OpenVMS Cluster that
is not specified in the list when the logical is defined, will not run the License
Server.
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Note

If you define PWRK$LS_LICENSE_NODES, and define
PWRK$LICENSE_SERVER_INHIBIT (described above), the settings
you define with PWRK$LS_LICENSE_NODES supersede any settings
defined with PWRK$LICENSE_SERVER_INHIBIT.

3.5 Synchronizing the License Server Database with the LMF
Database

The number of client-based licenses available for a product may change
because additional product licenses are added to the LMF database, or existing
licenses are unloaded, disabled, deleted, or expired from the LMF database.

The License Server must check the LMF database to verify license counts
for products currently in the License Server database. The License Server
database is updated to reflect LMF database changes at the following times:

• When the License Server is restarted.

• Automatically, once every 24 hours, typically at 00:01 (system time). See
Section 3.5.2, Scheduling the LMF Synchronization, for more information.

• When requested by the License Manager for individual license types.

You can change the time at which the synchronization occurs by defining
the logical PWRK$LSLMFSYNCHMINUTES, as described in Section 3.5.2,
Scheduling the LMF Synchronization.

3.5.1 How License Database Changes Impact the License Server
After a license database update occurs, the new numbers you see in the License
Manager screens may indicate that you must make some adjustments to your
group license allocations.

Changes made to the number of available client-based licenses impact the
License Server and clients in the following ways:

• If you add client-based licenses to the License Server database, the License
Server automatically adds them to the Default group.

• If you remove client-based licenses, the License Server checks the Default
group and each of the other groups and automatically removes unassigned
licenses from the groups to match the number of licenses lost.
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• When the number of licenses removed is greater than the number of
unassigned licenses, the License Server revokes one or more assigned
licenses to satisfy the count. The selection of which licenses to remove is
completely arbitrary. Clients with their licenses revoked have to request
new ones.

When licenses have been unloaded or deleted, use one of the following
strategies to accommodate client needs:

• Redistribute license allocations among the groups.

If, after an LMF database synchronization, some groups still have extra
licenses, consider moving the licenses to groups that need additional
licenses to cover client needs.

• Redirect clients to other groups.

If you do not want to change the license allocation for a group, consider
redirecting some clients to a group that has available licenses.

• Obtain additional licenses.

If the overall number of licenses is no longer equal to or greater than the
number of clients, purchase additional licenses and enter them into the
LMF database. You can then allocate them where needed.

3.5.2 Scheduling the LMF Synchronization
LMF synchronization occurs when the License Server database is updated to
reflect the system’s LMF database. You can schedule the LMF synchronization
to occur when it is most convenient for your system. By default, the
synchronization operation occurs at 00:01 system time. To specify a
different time for the synchronization to occur, define the logical name
PWRK$LSLMFSYNCHMINUTES in the system logical name table equal
to the number of minutes past midnight that the LMF synchronization occurs.

For example, if you want the LMF synchronization to occur at 4:15 A.M.,
compute the number of minutes after midnight:

4:15 AM = (4 hours x 60 minutes/hour) + 15 minutes
= 255 minutes past midnight

Then add the following line to the system’s startup command procedure:

$ DEFINE/SYSTEM PWRK$LSLMFSYNCHMINUTES 255

New synchronization times take effect only after the file server is restarted
after the new value is established.
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4
Managing Licenses on the OpenVMS

Platform

This chapter describes how to configure, start up, and use the License Manager
to manage client licenses from an OpenVMS server. It discusses the following
topics:

• Section 4.1, Getting Started with the License Manager, describes the
privileges required to run the License Manager and the command used to
start the License Manager.

• Section 4.2, Configuring the License Server, describes the errors that occur
when the License Server is not configured, or when you attempt to run the
License Manager on a node that is not running the License Server.

• Section 4.3, Navigating in the License Manager, describes how to navigate,
with a mouse or keyboard, in the License Manager screens.

• Section 4.4, Performing License Server Tasks, describes how to start and
stop the License Server and how to manage the License Server log files.

• Section 4.5, Performing License Product Tasks, describes tasks you perform
to manage license products.

• Section 4.6, Performing License Group Tasks, describes tasks you perform
to manage license groups.

• Section 4.7, Performing Client License Tasks, describes tasks you perform
to manage client licenses.
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4.1 Getting Started with the License Manager
The OpenVMS account used to run the License Manager must have the
following privileges:

• SYSLCK

• TMPMBX

• NETMBX

4.1.1 Starting the License Manager
To start the License Manager, enter the following command from the system
where the License Server is running:

$ ADMINISTER/LICENSE_MANAGER

When you start the License Manager, the screen shown in Figure 4–1, Main
Menu Screen, appears.

Figure 4–1 Main Menu Screen
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Advanced Server License Manager
View Actions Options Help
List of License Products
Product Total In Use AlertAvail

Press F10 or PF1, PF1 to select a menu
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The menu toolbar contains the following menu items:

• View menu—allows you to select the item you will manipulate with the
License Manager:

Products

Groups

Client Licenses

To perform management functions on a product, you choose Products from
the View menu, and then you choose the function you want to perform from
the Actions menu. The same process is used when performing management
functions on Groups or Client Licenses.

• Actions menu—provides functions that you perform on Products, Groups,
or Client Licenses depending upon the view you selected.

• Options menu—allows you to enable and disable the License Server and to
perform Log File options.

• Help menu—provides information about using the License Manager.

To select a menu, press F10 or PF1 and PF1 again. The system displays the
View menu as shown in Figure 4–2, Main Menu with View Menu Displayed.
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Figure 4–2 Main Menu with View Menu Displayed
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Display License Products
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Groups
Client Licenses
Exit

Products

If you want to display one of the other menus, use the arrow key to move the
cursor to that menu, or use your mouse.

4.1.2 Getting Help with the License Manager
To display information about using the License Manager, choose Help from the
menu bar. The Help menu displays two options:

• General Help

• Help with this screen

Select the appropriate help option. To exit the help screen, press Return. To
exit the list of topics, press F10.

4.1.3 Exiting the License Manager
To exit from the License Manager, follow these steps:

1. From the menu bar, choose View.

2. From the View menu, choose Exit.
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4.2 Configuring the License Server
If you attempt to start the License Manager when the License Server is not
running on the system, the message shown in Figure 4–3, License Server Error
Message, appears.

Figure 4–3 License Server Error Message
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ERROR

Unable to communicate with the license server

Continue

If the License Server has not been configured to run, you must reconfigure the
file server. Run the initial configuration procedure (PWRK$CONFIG.COM)
and specify that you want to run the License Server. For information
about configuring the file server, and additional information about the
PWRK$CONFIG.COM command procedure, refer to the Server Installation
and Configuration Guide for your Advanced Server product.

In an OpenVMS Cluster, if you attempt to start the License Manager on a
node that is not running on the active License Server and the License Server
is active on another member of the cluster, the error message in Figure 4–4,
License Server Startup Error Message, appears.

Figure 4–4 License Server Startup Error Message
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ERROR

License Server is running on node 'ALPHA'

Continue

To run the License Manager, issue the ADMINISTER/LICENSE_MANAGER
command on the node that is running the active License Server (defined as
ALPHA in the License Server Startup Error Message).
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4.3 Navigating in the License Manager
The following tables describe the keys and buttons you use to navigate within
and between the License Manager screens. You can control the License
Manager using a mouse or using keys on the keyboard. Using the mouse, you
can navigate through the License Manager screens by pointing and clicking
on the desired item to select (highlight) items in the menus, scroll boxes, or
dialog boxes. This discussion assumes you are using a DECterm window or an
equivalent emulator.

Table 4–1 Keys for Navigating Screens

Use this key... To...

Arrow keys Navigate up and down lists and input fields, and across menu
options and buttons.

F10 Select a menu.

Comma
(keypad)

Enable and disable selection of multiple lines in a scroll region.
When you perform an action on multiple lines (for example,
removing a group), a confirmation box is displayed. For information
on confirmation box options, see Table 4–2, Confirmation Box
Selections.

Space bar Enable or disable the item selection. Selected items are highlighted.

Tab Move the cursor from field to field in a screen or dialog box.

Return Display the screen or dialog box associated after selecting a task
and remove the message window after an error message has been
displayed.

Hot key Select the menu item list or input field whose hot key is highlighted.
Used with PF1, they are the letters in the menu items that are
underlined. For example, press PF1 G at the View menu for a list of
server groups.

Enter . . . To select . . .

PF1, V View Menu

PF1, A Actions Menu

PF1, O Options Menu

PF1, H Help
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Table 4–2 Confirmation Box Selections

Select . . . To . . .

YES Confirm the action for each item selected.

YES TO ALL Perform the action on all selected items.

CANCEL Cancel the action.

Table 4–3 Buttons for Navigating Screens

Use this
button . . . To . . .

OK Confirm the actions you performed on a particular screen. After
choosing this button in a dialog box associated with a screen, you
are returned to the screen. After choosing this button at the bottom
of a screen, you are returned to the previous screen.

Help Display help text. To exit the screen, press Return. To exit the list
of topics, press F10.

Cancel Cancel the actions you just performed.

4.3.1 Navigating Fields in a Dialog Box
When you enter values in a dialog box that has several fields, use the up and
down arrow keys to navigate back and forth between the fields. You can back
up through the fields in this way to change a value as long as you have not
pressed Return to commit the values.

4.4 Performing License Server Tasks
License Server tasks include managing the License Server log files and
enabling and disabling the License Server. These tasks are performed through
the following Options menu items:

• Log File Options . . .

• Server Enable/Disable . . .
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4.4.1 Disabling and Enabling the License Server
In most cases, invoking the License Manager enables the License Server. HP
recommends that you disable the License Server before you use the License
Manager to add, move, or remove any licenses within license groups. However,
it is not necessary to disable the License Server before performing other
operations. If the License Server is enabled while you manage licenses, it can
assign the same licenses you are managing, causing unpredictable results.

Whenever you exit the License Manager, the License Server is automatically
reenabled.

In certain circumstances, if the License Server finds no License Server state
file in the PWRK$LICENSE: directory, the License Server disables itself, logs a
message in the License Server log file and operator console, creates the default
License Server state file, and remains disabled until the License Manager
enables it. For additional information about the License Server state file, see
Section 3.1, License Server State Files.

To disable or enable a License Server, follow these steps:

1. From the Main menu bar, choose Options.

2. From the Options menu, choose Server Enable/Disable ...

The screen shown in Figure 4–5, Server Enable/Disable Screen, appears.

Figure 4–5 Server Enable/Disable Screen
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Server Options

OK Cancel Help

License Server Name:
Node Name:

ALPHA1
ALPHA1

(*) Enable Server ( ) Disable Server

3. Choose either Enable Server or Disable Server. An asterisk next to the
option means that the option is selected.

4. Press Return or choose the OK button to complete the operation and return
to the Main menu.
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4.4.2 Performing Log File Tasks
You can perform the following log file tasks using the License Manager:

• Choose which License Server events to record in the License Server log file.

• Create a new version of the server log file.

You can read or purge old versions of the server log file as you would any
OpenVMS file. The file name and location is:

PWRK$LOGS:PWRK$LICENSE_SERVER_servername.LOG

PWRK$LOGS is defined in the system logical name table when the License
Server is started. The servername is usually the OpenVMS Cluster alias or
the node name of the system the License Server is running on. For example, if
your node is NASCAR, the file name and location is:

PWRK$LOGS:PWRK$LICENSE_SERVER_NASCAR.LOG

4.4.2.1 Enabling Events for Logging
You can enable logging for events associated with the following operations:

• Successful license requests

• Failed license requests1

• License verifications

• Verification requests denied1

• Licenses released

• Server startup1 (Note that you cannot change this.)

• License alert event1

• Client address changes1

• Client ID changes1

• Server enable/disable actions

• Licenses revoked1

• Fatal server error1 (Note that you cannot change this.)

You can disable the logging of all events except server startup and fatal server
errors.

1 These events have logging enabled by default when the License Server is first started.
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If you are experiencing any problems with the license management software,
HP recommends that you enable the logging of all types of License Server
events. This will provide you with a comprehensive log file that provides
information to assist in troubleshooting licensing problems.

4.4.2.2 Selecting Events for Logging
To select the events you want to log, follow these steps:

1. From the Main menu bar, choose Options.

2. From the Options menu, choose Log File Options . . .

A screen similar to the one shown in Figure 4–6, Log File Options Screen,
appears.

Figure 4–6 Log File Options Screen
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Log File Options

[ ] Successful License Requests
[X] Failed License Requests
[ ] License Verified
[X] Verification Request Denied
[ ] License Released
[X] License Alert
[X] Client Address Change
[X] Client ID Change
[ ] Server Enabled/Disabled
[X] License Revoked

OK Cancel Clear All Select All Help

(*) Log These Events ( ) Do Not Log

Start New Logfile

3. Select the events for which you want to enable or disable logging.

Using the space bar or the mouse, toggle the event to either enabled or
disabled. A mark (X) next to the event indicates that the event is enabled.
You cannot disable server startup events or fatal server error events.

4. Choose OK to confirm or one of the following options:

4–10 Managing Licenses on the OpenVMS Platform



Managing Licenses on the OpenVMS Platform
4.4 Performing License Server Tasks

Option Description

Cancel Cancel your selections.

Clear All Clear all settings.

Select All Select all settings.

Help Get help on log file options.

Start New Logfile Create a new log file instead of continuing to append
information to the existing log file. The log file can
become long. This option allows you to start a log file
from today.

4.4.2.3 Creating a New Version of the Log File
A log file can grow quickly when tracking many events. When a log file
becomes too large, you can create a new version of the file.

To create a new version of the log file, follow these steps:

1. From the Main menu bar, choose Options.

2. From the Options menu, choose Log File Options . . .

3. From the Log File Options screen, choose Start New Logfile.

4. Choose OK in the Confirmation screen.

5. Choose OK in the Log File Options screen.

4.5 Performing License Product Tasks
You can use the License Manager to perform the following product license
tasks:

• Add product licenses to the License Server

• Remove product licenses from the License Server

• Display the groups that have licenses allocated from a specific product

• Set alert levels for product licenses

• Generate product reports

• Sort the display of products in the License Manager
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4.5.1 Adding Product Licenses
To add new or additional product licenses to the License Server, follow these
steps:

1. From the View menu, choose Products.

2. From the Main menu bar, choose Actions.

3. From the Actions menu, choose Add . . .

The screen shown in Figure 4–7, Add License Product Screen, appears.

Figure 4–7 Add License Product Screen
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Add License Product

OK Cancel Help

Product ____________________________________

4. Enter the license product name in the text entry field, for example,
PWLMXXXCA07.03.

5. Choose OK.

You can use the same procedure to add additional product licenses later.

4.5.2 Removing Product Licenses
When a product is no longer needed, remove its licenses. You cannot remove a
single license for the product with the License Manager; you must remove the
product, which in turn removes all licenses.
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Note

When removing the product licenses from the License Manager, first
remove them from the LMF database as described in the HP OpenVMS
License Management Utility Manual. If you do not remove the licenses
from the LMF database, they may continue to be assigned to clients.

Removing all licenses for a product from the License Manager and the LMF
database prevents clients from acquiring a license the next time they try. If
removed licenses are currently assigned to clients, those licenses are revoked
and the client is informed that the license was revoked the next time the client
attempts to verify the license.

To remove all licenses for a product, follow these steps:

1. Remove the licenses from the LMF database as described in the HP
OpenVMS License Management Utility Manual.

2. From the View menu, choose Products.

3. From the List of License Products screen, choose the product you want to
remove.

4. From the Actions menu, choose Remove.

A dialog box appears in which you can confirm or cancel the removal.

5. Choose Yes to confirm the removal.

4.5.3 Listing Product Allocations
To display the groups that have licenses allocated from a specific product,
perform the following steps:

1. From the View menu, choose Products.

2. From the List of License Products screen, choose the product you want to
display allocation details for.

3. From the Actions menu, choose Show Details (or double-click on the
product).

The system displays a list of groups that have allocations of the selected
product.

4. Choose OK to confirm and return to the Main menu.
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4.5.4 Sorting Product Displays
You can sort the display of the products in the List of License Products screen.
You can sort by:

• Product name

• Licenses available

• Licenses in use

By default, the list of products are displayed by product name. Perform the
following steps to specify a different sort option:

1. From the View menu, choose Products.

2. From the Actions menu, choose Sort By . . .

The screen shown in Figure 4–8, Sort Options for Products Screen, appears.

3. Choose the sort option you want.

4. Choose OK.

The selected sort option also effects the sort order for any product reports
generated. (See Section 4.5.6, Generating Product Reports.)

Figure 4–8 Sort Options for Products Screen
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4.5.5 Setting the Alert Level for Product Licenses
To set the alert level for product licenses, perform the following steps:

1. From the View menu, choose Products.

2. From the List of License Products screen, choose the product you want to
set the alert level for.
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3. From the Actions menu, choose Modify.

4. Set the alert level. If the alert level is set to zero (0), you will not receive
an alert when no licenses are available. The maximum value you can set
the alert level to is the total number of licenses. As you manage licenses,
you want to set the alert level to the number that makes most sense in
your environment. When the number of licenses drops to this level, you
receive an alert.

When the number of assigned licenses reaches this value, an entry is
added to the License Server log file. For more information, see Appendix A,
Server Messages.

5. Choose OK to confirm and return to the Main menu.

4.5.6 Generating Product Reports
To generate a product report, follow these steps:

1. From the View menu, choose Products.

2. From the List of License Products screen, choose the product you want to
generate a report for.

3. From the Actions menu, choose Generate Product Report.

The system displays the File Name dialog box.

4. Enter the name for the report in the File Name dialog box.

5. Choose OK to confirm and return to the Main menu.

By default, the report is written to the current default directory, unless another
directory is specified in the File Name dialog box. By default, the list of
products are listed by product name. You can also have the report sorted by
licenses available or licenses in use, as explained in Section 4.5.4, Sorting
Product Displays.

4.6 Performing License Group Tasks
You can use the License Manager to perform the following license group tasks:

• Create license groups

• Allocate licenses for a product to a group

• List the clients in a license group

• List the product licenses that a group has licenses allocated from, and how
many such licenses are in use

• Move or remove licenses from a group
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• Remove a group

• Set the alert level for licenses in a group

• Generate group reports

• Sort the display of groups in the License Manager

4.6.1 Creating License Groups
When the file server software is initially installed, the Default group and the
Server-Based group are created automatically. Any license products that are
loaded onto the system are automatically placed in the Default group. To
enable server-based licensing, you must allocate licenses from the Default
group to the Server-Based group.

You can create user-defined license groups. These additional groups are for
client-based licensing and are used to organize the distribution of licenses.
The groups you create typically reflect the organizations that you support. For
example, you may create the groups Engineering, Finance, and Marketing
because these are the organizations you support. To utilize these groups, client
software is configured so that a license is requested from that group.

To create a group, follow these steps:

1. From the Main menu bar, choose View.

2. From the View menu, choose Groups.

3. From the Actions menu, choose Add.

The dialog box shown in Figure 4–9, Add New Group Screen, appears.

Figure 4–9 Add New Group Screen
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Group Name: ________________________________

4. Enter the name of the group you wish to create.

5. Choose OK.
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When you create a group, the license allocation is set to zero. You must use the
Modify Group function to allocate licenses to the new group.

4.6.2 Listing Licenses in a Group
You can use the License Manager to determine how many licenses from each
product have been assigned to each group. To list how many licenses have been
assigned to a specific group, follow these steps:

1. From the View menu, choose Groups.

2. From the List of License Groups screen, choose a Group.

3. From the Actions menu, choose Show Details (or double-click on the group).

A Products screen similar to the one shown in Figure 4–10, Products
Screen for Products in a Group, appears.

Figure 4–10 Products Screen for Products in a Group
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4.6.3 Sorting Group Displays
You can sort the display of the groups by:

• Product name

• Licenses available
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• Licenses in use

To specify a sort option, follow these steps:

1. From the View menu, choose Groups.

2. From the Actions menu, choose Sort By . . .

The screen shown in Figure 4–11, Sort Options for Groups Screen,
appears.

Figure 4–11 Sort Options for Groups Screen
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3. Choose the sort option you want.

4. Choose OK.

The selected sort option also effects the sort order for any group reports
generated. (See Section 4.6.8, Generating Group Reports.)

4.6.4 Allocating Licenses to a Group
When you create a group, no licenses are automatically allocated to it. To
allocate licenses to a group, you move them from the Default group to the
group you want them in. You can allocate licenses at any time to any group
except the Default group.

Note

You cannot allocate licenses to the Default group. If you specify a
product under the Default group, you can set only its alert level in this
dialog box.
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To allocate licenses to a group, follow these steps:

1. From the View menu, choose Groups.

2. From the List of License Groups screen, choose the group that you want to
allocate licenses to.

3. From the Actions menu, choose Modify . . .

The dialog box shown in Figure 4–12, Modify License Product Allocation
Screen, appears.

Figure 4–12 Modify License Product Allocation Screen
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Product allocation for group Server-Based
Product Alloc Alert
PWLMXXXCA07.03 15 0

OK Cancel Help

PWLMXXXCA07.03

________ (max 100)
________

Allocation:
Alert:

15
0

Each field in the dialog box is displayed with a value. You can change the
allocation and alert fields.

4. Enter your value changes in the Allocation and Alert fields.

5. Press Return or choose OK.

Table 4–4, Allocation and Alert Field Descriptions, describes the fields in the
Modify License Product Allocation Screen.
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Table 4–4 Allocation and Alert Field Descriptions

Field Description

Product The name of the product you chose. You cannot alter this field.

Max The number of licenses in the Default group that are available for you to
allocate to the group. If there are no available licenses for the product, the
value of this field is 0. You cannot alter this field.

Alert The number of licenses of this product allocated to this group that triggers
a message warning you that the licenses used have reached this level. For
example, if you have 100 product licenses allocated to the Services Group
and have set the alert level to 90, when you have used the 90th license of
this product in the Service Group, you receive a warning message.

Allocation The number of licenses you want to allocate to the group. If licenses have
been previously allocated, the value displayed for this field tells you how
many. If no licenses have been previously issued, the value displayed is 0.

You can change this number to any number from 0 to the number indicated
in the maximum field. If you decrease the number, the difference is
returned to the Default group. If you increase the number, the increment
is deducted from the Default group.

To allocate licenses, add a number to the value displayed for this field that
is equal to or less than the value of the maximum ‘‘Licenses available to
issue’’ field.

You cannot allocate more licenses to the group than are available from the
Default group.

4.6.5 Reallocating Licenses to Another Group
If you have excess licenses in one group and not enough in another, you may
want to change license allocations. To reallocate licenses, you decrease the
number of allocated licenses from one group, which automatically assigns them
to the Default group, and then you allocate the available licenses to another
group.

To reallocate licenses to another group, follow these steps:

1. From the Main menu bar, choose View.

2. From the View menu, choose Groups.

3. From the list of groups displayed in the Main screen, choose the group that
you want to remove licenses from.

4. From the Main menu bar, choose Actions.

5. From the Actions menu, choose Modify . . .

The system displays the Product Allocation screen.
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6. Modify the license allocation.

7. Choose OK.

The licenses that you remove are returned to the Default group. The List
of License Groups screen is displayed.

8. From the List of License Groups screen, choose the group that you want to
increase the number of licenses allocated to.

9. From the Actions menu, choose Modify . . .

10. In the Product Allocation screen, increase the number of licenses allocated
to the group.

The reallocated licenses are deducted from the Default group.

11. Choose OK.

4.6.6 Removing Groups
Removing a group deletes the group and causes the following actions:

• Assigned licenses held by clients from that group are revoked.

• All licenses allocated to that group return to the Default group.

• Clients can no longer be assigned licenses from that group.

Note

Clients that request licenses from this group must be reconfigured to
request licenses from a different group. For more information, refer to
the appropriate client licensing software configuration help utility.

To remove a group, follow these steps:

1. From the View menu, choose Groups.

2. From the List of License Groups screen, choose the group you want to
remove.

3. From the Actions menu, choose Remove.

The system displays the Confirm Group Removal dialog box.

4. Choose Yes to remove the group.
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Note

Any user-defined license group can be removed; the predefined
Default group and the Server-Based license group cannot be removed.
Removing a license group has the following consequences:

• Any licenses from the selected group that have been assigned to
clients are revoked.

• All licenses allocated to the group you are removing are reassigned
back to the Default license group.

4.6.7 Setting the Alert Levels for Groups
To set the alert levels, follow these steps:

1. From the View menu, choose Groups.

2. From the List of License Groups screen, choose the group you want to set
the alert level for.

3. From the Actions menu, choose Modify . . .

4. Set the alert level.

5. Choose OK to confirm and return to the Main menu.

Note

You cannot set the alert level for the Server-Based group of licenses.

4.6.8 Generating Group Reports
To generate group reports, follow these steps:

1. From the View menu, choose Groups.

2. From the List of License Groups screen, choose the group you want to
generate a report for.

3. From the Actions menu, choose Generate Group Report.

The system displays the File Name dialog box.

4. Enter the name for the report in the File Name dialog box.

5. Choose OK to confirm and return to the Main menu.
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By default, the report is written to the current default directory, unless another
directory is specified in the File Name dialog box. By default, the list of groups
are listed by product name. You can also have the report sorted by licenses
available or licenses in use, as explained in Section 4.6.3, Sorting Group
Displays.

4.7 Performing Client License Tasks
Details about a client are available to the License Manager when the client
is assigned a license or when an existing license is verified. If a client does
not have a user name as configured by the PATHWORKS Client Configuration
utility (PWSETUP), the client appears as <noname>.

You can perform the following client-related tasks:

• Revoke a client license

• Show details about a client

• Sort the display of current clients

• Generate a client report

4.7.1 Revoking Client Licenses
When you revoke a client’s license, you can reassign the license to another
client or to the same client the next time the client requests a license from that
group. When a client’s license is revoked, the client must request a new one to
access the file server again.

You may want to revoke a client’s license for any of the following reasons:

• The client moved to a new organization.

• The client was assigned a license from the wrong group.

• The client’s hardware configuration has changed.

To revoke a license assigned to a client, follow these steps:

1. From the View menu, choose Client Licenses.

The screen shown in Figure 4–13, List of Client Licenses Screen, appears.
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Figure 4–13 List of Client Licenses Screen
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Product TimestampGroup
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PWLMXXXCA07.03 default
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09/23/00 13:52:56
09/27/00 10:27:53
10/08/00 11:18:32
10/08/00 11:18:33
09/23/00 10:47:22

Press F10 or PF1, PF1 to select a menu

2. Select the client license you want to revoke. Make sure the client with the
desired product is selected (highlighted).

3. From the Actions menu, choose Revoke.

The dialog box shown in Figure 4–14, Confirm Revocation of Client License
Screen, appears.

Figure 4–14 Confirm Revocation of Client License Screen
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Revoke License for: MERZ1
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4. Choose Yes to revoke the license.
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4.7.2 Showing Client Details
You can show the following detailed information about each client. These
details are gathered when the client workstation requests a license from the
License Server.

Table 4–5 Client Details Field Description

Name Meaning

Client Name The name of the client.

Client ID The unique client identifier (most often the address from a network
adapter card in the client system).

User name The user name configured with the PATHWORKS Client
Configuration utility.

NetBIOS name The machine name of the workstation.

TCP/IP host The name of the TCP/IP client node.

DECnet node The name of the DECnet client.

Product The license product assigned to the client.

Group The group name from which the license was assigned.

Timestamp The date and time the license was issued.

To show details for a client, follow these steps:

1. From the View menu, choose Client Licenses.

2. From the List of Client Licenses screen, choose the client for which you
want to show details.

3. From the Actions menu, choose Show Details (or double-click on the client).

Detailed information for that client, similar to that shown in Figure 4–15,
Client Details Screen, appears.
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Figure 4–15 Client Details Screen
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4.7.3 Sorting Client License Lists
You can sort the order in which clients are displayed in the List of Client
Licenses screen. To specify a sort order, follow these steps:

1. From the View menu, choose Client Licenses.

2. From the Actions menu, choose Sort By . . .

The dialog box shown in Figure 4–16, Sort Options for Licenses Screen,
appears.

Figure 4–16 Sort Options for Licenses Screen
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(*) Client Name
( ) User Name
( ) Product
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( ) Timestamp

3. Choose the sort option you want.
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4. Choose OK.

The selected sort option also effects the sort order for any client license reports
generated. (See Section 4.7.4, Generating Client License Reports.)

4.7.4 Generating Client License Reports
You can generate client license reports showing all client licenses that are
currently in use, including the following information:

• Client name

• User name

• Product

• Group

• Timestamp

You can change the order of the client license information by using the Sort
option as described in the Section 4.7.3, Sorting Client License Lists. To
generate a client license report, follow these steps:

1. From the View menu, choose Client Licenses.

2. From the Actions menu, choose Generate Client Report.

The dialog box shown in Figure 4–17, File Name for Report Dialog Box,
appears.

Figure 4–17 File Name for Report Dialog Box
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File Name for Report
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OK Cancel Help

File Name: _____________________________________________________

3. Enter the name for the report in the dialog box.

4. Choose OK.

Unless a directory is included in the file name, the report is placed in the
current default directory.
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This chapter briefly describes the licensing components that run on the client
computer and how to obtain them. These components communicate with
the licensing software components (License Registrar and License Server).
(The licensing software components are described in Chapter 1, How to Use
Advanced Server License Software.) This chapter also explains how to enable
client computers to obtain licenses over a wide area network (WAN).

This chapter includes the following topics:

• Section 5.1, Client Licensing Software Components and When to Install
Them, describes when and what client licensing components are required
by the client computer.

• Section 5.2, How to Obtain the Client Licensing Software, describes how to
obtain the licensing software components.

• Section 5.3, Enabling Wide Area Network (WAN) Operations, describes
how to configure the client computer to access a License Server that is not
in the same local area network (LAN).

5.1 Client Licensing Software Components and When to
Install Them

To obtain a client-based license from the License Server, the client computer
must be running the software for license acquisition — the client licensing
software. This software enables the client computer to request and store
license information for access to the file server.

Note

If you plan to use server-based licensing only, the software components
described in this chapter are not required.
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The client license components include:

• Client License Requester (CLR)

• Client License Transponder (CLT)

The CLR works with the License Server to assign licenses to your client
system. It also checks with the License Server at startup time to see if the
license has been revoked by the network administrator. The CLT stores
assigned licenses and presents them to the file server when asked.

For information on client licensing messages, such as the system error message
you receive when you attempt to access the file server without a license, or
the messages you receive when you run the Client Transponder or Client
Requester software, see the appropriate client online help utilities.

Clients use the same transports to obtain and use their license keys as they
do to access their file services. For clients connecting to the server using
a dial-up connection, or from a local area network (LAN) other than the
server’s LAN, extra steps may be required to obtain a license. Procedures
for dial-up connections are described in the README.TXT file provided
with the Advanced Server PWLICENSE share on the file server. Procedures
for connections from a LAN other than the server’s LAN are described in
Section 5.3, Enabling Wide Area Network (WAN) Operations.

5.2 How to Obtain the Client Licensing Software
You can obtain client licensing software from the following sources:

• If the client computer is not running PATHWORKS client software (such
as PATHWORKS 32), the client licensing software can be obtained from
the PWLICENSE share that is created when the Advanced Server for
OpenVMS software kit is installed and configured. This is the preferred
source, because the client licensing software obtained from there will
request a license appropriate for accessing the current Advanced Server for
OpenVMS product. You will not have to update the default license name.

Note

Windows 2000 and Windows 2003 clients can obtain client license
software from the PATHWORKS 32 distribution kit. Ensure that
server-based licensing is enabled so that clients can access the
PWLICENSE share and install the client licensing software.

5–2 Client Licensing Software



Client Licensing Software
5.2 How to Obtain the Client Licensing Software

• If the client computer is already running PATHWORKS client software,
the client licensing components may be automatically installed as part of
the default client software installation. If you do not have PATHWORKS
client software running, you can still obtain the client licensing components
from the PATHWORKS client software distribution kit (for Windows 2000
clients, you need to obtain the licensing software from the PATHWORKS 32
Version 7.4 distribution kit, the PWLICENSE share, or from HP customer
support.). In either case, you might have to update license component
information to ensure access to the current Advanced Server for OpenVMS.

Note

To connect to the PWLICENSE share from a client that has not yet
obtained a client-based license, a server-based license must be available
to assign to the client. If necessary, use the License Manager to
allocate a license to the Server-Based license group.

For information about installing the client licensing software, refer to the
README.TXT file provided in the Advanced Server PWLICENSE share
provided on the file server.

5.3 Enabling Wide Area Network (WAN) Operations
This section provides the basic information you need to configure licensing
software on client computers that are not in the same LAN as the License
Server and that must acquire client-based licenses.

When the License Server that is to provide client-based licenses is not in the
same LAN as the client system, the following two steps are required to set up
the client system:

1. Configure the WAN protocol stack (DECnet or TCP/IP) to map the License
Server’s NetBIOS name (usually the node or host name with the prefix
‘‘PWRK$L’’) to the WAN address of the License Server system, as explained
in Section 5.3.1, Configuring the WAN Protocol Stack for WAN Licensing.

2. Configure the licensing software components with the name of the License
Server, as explained in Section 5.3.2, Configuring the License Server Name.
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5.3.1 Configuring the WAN Protocol Stack for WAN Licensing
For the CLR to communicate with a License Server, the client system must be
able to resolve the NetBIOS name of the License Server. Client computers on
the same LAN as the License Server can use broadcasts to locate the License
Server. However, client computers outside the local area network where the
License Server is running must use one of the following methods to resolve the
NetBIOS name of the License Server:

• Using TCP/IP

– WINS (Windows Internet Name Service)

If the License Server is configured as a WINS client, the License
Server name will be registered on the WINS server. Clients can then
use WINS to resolve the License Server name. For more information
about configuring the License Server as a WINS client, refer to the
Server Administrator’s Guide for your Advanced Server product. This
configuration is supported in Microsoft TCP/IP network environments
on Windows NT 4.0, Windows 2000, Windows XP and Windows 2003.

– LMHOSTS file

If the client is using Microsoft TCP/IP, an LMHOSTS file may be used
to map TCP/IP addresses to NetBIOS names.

Search for the file LMHOSTS. If it does not exist, search for the file
LMHOSTS.SAM and make a copy in the same directory, naming the
copy ‘‘LMHOSTS.’’

Edit LMHOSTS using whatever text editor you like and add the
following line:

tcp-address PWRK$Lname #PRE

For example, if the License Server system has a TCP/IP address of
12.34.56.78, and the License Server is running on node ‘‘ZIPHED’’, add
the following line:

12.34.56.78 PWRK$LZIPHED #PRE

• Using DECnet

If the client computer is running DECnet, a Remote Adapter Name can be
defined to translate the License Server name to a DECnet address.

At the command prompt, issue the following command:

NCP DEFINE REMOTE-ADAPTER-NAME PWRK$Lname NODE decnet-address
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For example, if the License Server system has a DECnet address of 12.345,
and the License Server is running on node ‘‘ZIPHED’’, enter the following
line:

NCP DEFINE REMOTE-ADAPTER-NAME PWRK$LZIPHED NODE 12.345

5.3.2 Configuring the License Server Name
Once the WAN protocol stack has been configured to map the NetBIOS name
of the License Server to the WAN address of the License Server system,
configure the licensing software on the client, specifying the NetBIOS name
of the License Server. On Windows NT 4.0, Windows 2000, Windows XP and
Windows 2003 clients, run the program PNLCFG.EXE and add the License
Server to the list of ‘‘Remote License Servers’’ in the dialog box.
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A
Server Messages

This appendix explains the event messages that are logged to the License
Server and License Registrar log files as well as the Event Logger
(ADMIN/ANALYZE). It provides the License Server and License Registrar
messages, an explanation of these messages, and corrective action if
appropriate. It includes the following topics:

• Section A.1, License Component Log Files, describes the types of log files.

• Section A.2, License Server Events, describes events logged to the
OpenVMS License Server log file.

• Section A.3, License Registrar Events, describes events logged to the
License Registrar log file.

• Section A.4, Event Logger (ADMIN/ANALYZE) Messages, describes how to
check the events logged to the Event Logger (ADMIN/ANALYZE) during
file server operations.

For information on client licensing messages, such as the system error message
you receive when you attempt to access the file server without a license, or
the messages you receive when you run the Client Transponder or Client
Requester software, see the appropriate client online help utilities.

A.1 License Component Log Files
Log files are stored in a directory defined by the PWRK$LOGS logical name.
The two types of log files are:

• License processing-related log files

• License component program log files
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A.1.1 License Processing-Related Log Files
The names of the license processing-related log files are as follows:

• License Server log file:

PWRK$LOGS:PWRK$LICENSE_SERVER_name1.LOG

where name1 is either the OpenVMS Cluster alias name or the name of
the node on which the License Server is running.

In most cases, name1 is also used to form the License Server name on the
local system:

PWRK$Lname2

where name2 is the same as name1.

• License Registrar log file:

PWRK$LOGS:PWRK$LICENSE_REGISTRAR_name.LOG

The name is the system name.

A.1.2 License Component Program Log Files
The names of the license component program log files are as follows:

• License Server process:

PWRK$LOGS:PWRK$LICENSE_S_name1.LOG

where name1 is either the OpenVMS Cluster alias name or the name of
the node on which the License Server is running.

In most cases, name1 is also used to form the License Server name on the
local system:

PWRK$Lname2

where name2 is the same as name1.

• License Registrar process:

PWRK$LOGS:PWRK$LICENSE_R_name.LOG

The name is the system name.

A–2 Server Messages



Server Messages
A.2 License Server Events

A.2 License Server Events
This section describes events logged to the License Server log file
(PWRKS$LOGS:PWRK$LICENSE_SERVER_name.LOG). Note that all
the messages posted to the log file begin with a date/timestamp. Use the
License Manager to control what events are logged. The types of events that
the License Server posts to the License Server log file include:

• INIT_LOGFILE

• CLIENT_LICENSE_VALID

• CLIENT_LICENSE_INVALID

• CLIENT_ADDRESS_CHANGE

• SERVER_LICENSE_ASSIGNED

• SERVER_LICENSE_RELEASED

• MESSAGE

• FATAL_ERROR

ALERT_LEVEL_REACHED:
Product = product-name
Group = group-name
Alert Level = alert-level-number
Allocation = number-of-licenses-allocated
Explanation: The number of licenses currently in use for this product
exceeds the alert level. If the group-name is <none>, the alert level for all
the product’s licenses has been exceeded. Otherwise, the alert level for the
licenses in the specific group has been exceeded.
User Action: Review the current license distribution. Remove licenses
from clients that no longer use the product, redistribute the available
product licenses, or add new product licenses.

CLIENT_ADDRESS_CHANGE:
Client Id = client-id-number
Old Client Addr = old-address
New Client Addr = new-address
Explanation: The current client’s address is different from when the
license was assigned. Typically, this message indicates a license has been
moved from one client to another.
User Action: Make sure that the change of client ID is valid.
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CLIENT_ID_CHANGE:
Client Id = client-id-number
Old Client ID = old-id
New Client ID = new-id
Old Client Addr = old-address
New Client Addr = new-address
Explanation: The current ID of the client is different from the ID it
had when the license was assigned. The client ID is the address of the
Ethernet adapter. Typically, this message indicates that a license has been
reassigned from one client to another.
User Action: Make sure that the Ethernet address change is valid.

CLIENT_LICENSE_ASSIGNED:
Client ID = client-id-number
Client Addr = client-address
Transport = transport-name
Product = product-name
Group = group-name
Explanation: A product license was granted to the client from the group
specified.
User Action: None required.

CLIENT_LICENSE_DENIED:
Client ID = client-id-number
Client Addr = client-address
Transport = transport-name
Product = product-name
Group = group-name
Reason = explanation-string
Explanation: The client’s request for assignment of a license could not be
processed as requested.
User Action: If the reason is an incorrect product or group, check to be
sure the license type exists and reconfigure the client to obtain a valid
license. If there are not enough licenses, the administrator must add,
reallocate, or revoke licenses to create available ones.
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CLIENT_LICENSE_INVALID:
Client ID = client-id-number
Client Addr = client-address
Transport = transport-name
Product = product-name
Group = group-name
Reason = explanation-string
Explanation: The license presented for verification to the License Server
by the client is no longer valid.
User Action: If the reason is an incorrect product, group, or license, the
data on the client may no longer be valid (for example, the group may have
been deleted), or the license may have been revoked. Reboot the client to
obtain a valid license. If the license is in use by another client, this may
be a case of illegal copying of license data between clients and should be
investigated.

CLIENT_LICENSE_RELEASED:
Client ID = client-id-number
Client Addr = client-address
Transport = transport-name
Product = product-name
Group = group-name
Explanation: The system manager released the product license from the
specified group.
User Action: None required.

CLIENT_LICENSE_REVOKED:
Client ID = client-id-number
Client Addr = client-address
Product = product-name
Group = group-name
Reason = explanation-string
Explanation: The product license from the specified group was revoked
or removed. The reason string indicates whether it was due to an action
taken by the License Manager, or due to changes in the OpenVMS License
Management Facility (LMF) database. This action can explain why a
client’s license is considered invalid in a later log event.
User Action: You may have to add, reallocate, or revoke currently
allocated licenses to allow this client to use the file server in the future.
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CLIENT_LICENSE_UPGRADE_ON_ASSIGN:
Client Id = client-id-number
Client Addr = client-address
Transport = transport-name
Group = group-name
Current Product = version-product-name, for example PWLMDOSCC06.00,
PWLMXXCA06.00
Upgrade Product = product-name, for example, PWLMXXXCA06.00
Explanation: The client requested a PWLMDOSCC06.00 license and
the License Server has defined the logical so the License Server upgraded
and assigned the PWLMXXXCA06.00 license. The license returned to the
client will be a virtual license. (See the description under Explanation for
message, VIRTUAL_CLIENT_LICENSE_RETURNED_ON_ASSIGN.)
User Action: None required.

CLIENT_LICENSE_VALID:
Client ID = client-id-number
Client Addr = client-address
Transport = transport-name
Product = product-name
Group = group-name
Reason = explanation-string
Explanation: The license presented for verification to the License Server
by the client is valid.
User Action: None required.

FATAL_ERROR:
module-name: module-name and explanation-string
Explanation: An irrecoverable error has occurred that will cause the
License Server to terminate. The message may return the name of the
module in which the error occurred and an explanation of the possible
cause.
User Action: Notify your HP service representative or local authorized
reseller. Please save the log file so that it may be used to help diagnose the
problem.
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INIT_LOGFILE:
Reason = explanation-string
Explanation: A new version of the log file was created. The reason string
indicates whether it was done because the server started, or because of a
License Manager request.
User Action: None required.

MESSAGE: message-text
Explanation: The message displayed describes diagnostic log event
information.
User Action: None required.

SERVER_STATE_CHANGE:
Old State = previous-state-name
New State = new-state-name
Reason = explanation-string
Explanation: The License Server has been either enabled to serve the
client requests or disabled. The reason always indicates that it was at the
request of the License Manager.
User Action: None required.

VIRTUAL_CLIENT_LICENSE_RETURNED_ON_ASSIGN:
Client ID = client-id-number
Client Addr = client-address
Group = group-name
Product = product-name
Virtual Product = virtual-product
Explanation: The license requested by the client was a LAN Manager
license, for example, PWLMDOSCC06.00. The license software looks for a
higher version of the product than requested either through license version
lookup (described in Section 3.3, Controlling License Version Lookup) or
license upgrade (described in Section 2.5, Upgrading Client Licenses).
A license was assigned to that client, for example, PWLMXXXCA06.00.
Because the client will only accept a license name in the format of the
license requested, the License Server returns a ‘‘virtual license’’ to the
client that conforms to the original format requested. So the virtual license
returned is in the form, PWLMDOSCC07.00. The client will accept it as
simply a higher version of the PWLMDOSCC06.00 that it requested.
User Action: None required.
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A.3 License Registrar Events
This section describes the various events that can be logged to the License
Registrar log file (PWRK$LOGS:PWRK$LICENSE_REGISTRAR_nodename.LOG)
and the control logicals available to control the posting of events to the log file.

The types of events that the License Registrar posts to the License Registrar
log file include:

• INIT_LOGFILE

• CLIENT_LICENSE_VALID

• CLIENT_LICENSE_INVALID

• CLIENT_ADDRESS_CHANGE

• SERVER_LICENSE_ASSIGNED

• SERVER_LICENSE_RELEASED

• CLIENT_NOT_LICENSED

• MESSAGE

• FATAL_ERROR

By default, the License Registrar logs only the most significant events to
prevent the log file from growing too rapidly. If no control logicals are used to
indicate that additional events should be logged, the default behavior is to post
only the following types of events to the License Registrar log file:

• INIT_LOGFILE

• CLIENT_ADDRESS_CHANGE

• MESSAGE

• FATAL_ERROR

On occasion, it may be necessary to reconfigure the License Registrar to post
more detail about requests being processed. Should this become necessary,
use the following control logicals to control the type of events posted to the
License Registrar log file. These logicals determine the License Registrar’s
configuration parameter values while it is running.

• PWRK$LrLogVerbose

Turning this control logical on for the License Registrar causes messages
for all event types to be posted to the License Registrar log file.

A–8 Server Messages



Server Messages
A.3 License Registrar Events

If the PWRK$LrLogVerbose control logical is not turned on, the following
logging control logicals may be used to enable specific types of additional
logging.

• PWRK$LR_Log_ClientBased_Activity

Turning this control logical on will enable the posting of messages
related to the result of querying a client for a client-based license
appropriate for accessing the file server (CLIENT_LICENSE_VALID and
CLIENT_LICENSE_INVALID events).

• PWRK$LR_Log_ClientBased_Successes

Turning this control logical on will enable the posting of messages when the
License Registrar successfully validates a client-based license (CLIENT_
LICENSE_VALID events).

• PWRK$LR_Log_ClientBased_Failures

Turning this control logical on will enable the posting of messages when
the License Registrar does not receive a client-based license appropriate
for accessing the file server after querying a client running client licensing
software (CLIENT_LICENSE_INVALID events). In this case, the client
may not have returned any license or none of the licenses returned by the
client are valid for accessing the file server.

• PWRK$LR_Log_ServerBased_Activity

Turning this control logical on will enable the posting of
messages related to the assignment and release of server-based
licenses by the License Registrar (SERVER_LICENSE_ASSIGNED,
SERVER_LICENSE_RELEASED and CLIENT_NOT_LICENSED events).

• PWRK$Lr_License_Report_Interval

Setting this logical determines how often a license report is generated
and posted in the License Registrar log file. Set the logical by specifying
a numerical value, representing the intervals in seconds that reports
are generated. Each report lists all the clients currently connected
to the file server using server-based licenses. By default, no license
report is generated. For more information about setting this logical, see
Section A.3.1, Monitoring Consumption of Server-Based Licenses.

Each of these control logicals can be turned on by defining the logical
to a value of one (1). They can be turned off by leaving them undefined
or defining them to a value of zero (0). If the logical is defined, the
logical name must be defined in such a way as to make the definition
available to the License Registrar process (by defining a system logical
or defining the control logical in the License Registrar startup command
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procedure SYS$STARTUP:PWRK$LICENSE_R_START.COM). For
example, to always log events related to server-based licensing, turn on
the PWRK$LR_Log_ServerBased_Activity by defining the following system
logical:

$ DEFINE/SYSTEM PWRK$LR_Log_ServerBased_Activity 1

Note that these parameters affect reporting of individual events as they
happen. For example, when a client takes or releases a license, an event
message is logged reporting that activity. To generate reports that provide
statistics such as the number of server-based licenses currently in use, see
Section A.3.1, Monitoring Consumption of Server-Based Licenses.

CLIENT_ADDRESS_CHANGE:
Old Client Addr = old-address-name
New Client Addr = new-address-name
Explanation: The current network address of the client is different from
the one it had when the license was granted. This change may be valid, or
it may indicate the illegal copying of license data from the old client to the
new client.
User Action: Make sure that the change of address is valid.

CLIENT_LICENSE_INVALID:
Client ID = client-id-number
Client Addr = client-address
Product = product-name
Group = group-name
Reason = explanation-string
Explanation: The product license specified is no longer valid for the
client.
User Action: If the reason is an incorrect product, group, or license, the
data on the client may no longer be valid (for example, the group may have
been deleted). Reconfigure the client to obtain a valid license. If the license
is in use by another client, this may be a case of illegal copying of license
data between clients and should be investigated.
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CLIENT_LICENSE_VALID:
Client ID = client-id-number
Client Addr = client-address
Product = product-name
Group = group-name
Reason = explanation-string
Explanation: The product license from the group specified is still valid.
The reason string indicates whether the client license was actually
inspected or whether there was a cache entry match.
User Action: None required.

CLIENT_NOT_LICENSED:
Client ID = client-id-number
Client Addr = client-address
Transport = transport-name
Reason = explanation-string
Explanation: The client is not licensed to access the file server. The client
does not have a client-based license that grants it the right to access the
services provided by the file server and there are no server-based licenses
available for the License Registrar to assign to the client to give the client
access rights to the file server.
User Action: Either configure the client to acquire a client-based license
to access the file server or make server-based licenses available on the file
server system, which can then be used to license the client.

FATAL_ERROR: module-name: module-name and explanation-string
Explanation: An irrecoverable error has occurred that will cause the
License Registrar to terminate.
User Action: Notify your HP service representative or local authorized
reseller.

INIT_LOGFILE:
Reason = explanation-string
Explanation: A new version of the log file was created. The reason string
always indicates that it was done when the License Registrar started.
User Action: None required.

MESSAGE: message-text
Explanation: The message displayed describes diagnostic event
information.
User Action: None required.
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SERVER_LICENSE_ASSIGNED:
Product = product-name
Client Addr = client-address
Client ID = client-id-number
Allocation = total-number-of-server-based-licenses-assigned
Explanation: The client indicated did not have a client-based license
sufficient to access the local file server and was assigned a server-based
product license, granting the client the right to access the local file server.
The allocation indicates the number of server-based licenses in use after
assigning the license.
User Action: None required.

SERVER_LICENSE_RELEASED:
Product = product-name
Client Addr = client-address
Client ID = client-id-number
Allocation = total-number-of-server-based-licenses-assigned
Explanation: A client, previously assigned a server-based product license,
has disconnected from the file server. The server-based license previously
assigned to this client has been released. The allocation indicates the
current number of server-based licenses in use after the release of the
license.
User Action: None required.

A.3.1 Monitoring Consumption of Server-Based Licenses
To generate reports in the License Registrar log file that provide the number
of server-based licenses in use at any instant and a list of the clients using
these licenses, you can set the PWRK$LR_LICENSE_REPORT_INTERVAL
parameter. The value you assign to the parameter determines how frequently
these reports are generated. By default, no license report is generated.

Note

The value you specify determines the intervals in seconds that the
reports are generated. For example, if you want a report generated
every hour, specify a value of 3600. If you specify a value of 1, reports
are generated every second, which could cause the log file to grow
rapidly, using up an inordinate amount of disk space.

The name of the License Registrar log file is:

PWRK$LOGS:PWRK$LICENSE_REGISTRAR_nodename.LOG
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where nodename is the node name of the file server on which the License
Registrar runs. The PWRK$LR_LICENSE_REPORT_INTERVAL parameter
should be defined as a system logical so that you can change the value and
have the change take effect immediately (within 10 minutes) without having
to restart the server. The following example shows how to define the system
logical to generate reports every 30 minutes (30 x 60 seconds = 1800).

$ DEFINE/SYSTEM PWRK$LR_LICENSE_REPORT_INTERVAL 1800

The following is a sample report:

21-Sep-2000 08:34:54 MESSAGE:
-----------------------------------------------
License Registrar Server Based License Report

License: PWLMXXXCA07.03
Total: 99
Used this node: 1
Used Cluster Wide: 1
Available: 98

Client Address ClientId License Name
-------------- -------- ------------
"WALNGY " 62316936 PWLMXXXCA07.03

Note

Each node in an OpenVMS Cluster will have its own list of clients
using server-based licenses. To see what clients are connected to the
cluster, check all the cluster License Registrar log files.

A.4 Event Logger (ADMIN/ANALYZE) Messages
The Event Logger (ADMIN/ANALYZE) logs events during file server operation.
If a client is denied access to the file server, an entry is posted to the event log.
To check the event log, enter the following command:

$ ADMIN/ANALYZE

Look through the events displayed for access denied messages. For example:

No server license for client—access denied.
Explanation: The client is not licensed and no server licenses are
available; therefore, the client is denied access.
User Action: Obtain additional client-based or server-based licenses.
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